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1 Foreword 
 
Thank you for purchasing the Saia PG5 V2.0 package. This file contains tips and information to 
help you get the most out of the package, including a list of known issues, tips and frequently 
asked questions. We recommend that you review this file before using the PG5. 
 
Saia-Burgess has systematically and carefully designed, developed and tested this software 
product in many environments. Saia-Burgess has acquired the confidence that this product 
achieves a very high reliability. 
 
As with all other software tools, we recommend the user to regularly save and backup his project 
in order to minimise the risk of losing valuable work. 
 
 

1.1 Standard Disclaimer 
 
Neither Saia-Burgess Controls Ltd. nor anyone else who has been involved in the creation, 
production or delivery of the software shall be liable for any direct, indirect, consequential or 
incidental damages (including damages for loss of business profits, business losses, business 
interruption, loss of data and the like) arising out of the use or inability to use the software, or any 
other claim by any part even if Saia-Burgess Controls AG has been advised of the possibility of 
such damages. In the event that Saia-Burgess Controls AG is liable for any damages, liability 
shall be limited to the amount paid for the software under the terms and conditions of this 
agreement. 
 
The use and distribution of Saia PG5 software modules (for example, SComm DLL) with other PC 
applications is generally tolerated by Saia-Burgess, even though this use is not covered by the 
PG5 licence agreement. However, Saia-Burgess cannot accept any responsibility or claims 
resulting from the use of parts of the PG5 by other PC software applications. Should such an 
application cause any commercial damage or damage to the reputation of Saia-Burgess, we 
reserve the right to prohibit the use of PG5 software modules by other PC software applications. 
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1.2 Manuals available with the distribution DVD 
 
‘<DVD drive>:\ PG5_InstallationGuide_E.pdf’ 
The installation guide available on the distribution DVD inform you about, the necessary computer 
requirements to install this software, the description of the installation process, the licenses 
registration and many other useful information for the installation. 
 
‘<DVD drive>:\PG5 Suite\Manuals’ 
To start with this software, the main manuals are available on the distribution DVD. 

 
http://www.sbc-support.ch 
It is the link to Saia-Burgess Controls Product Support Website. PCD manuals can be viewed 
online using Acrobat Reader or downloaded and viewed locally. Downloads of service packs and 
PCD firmware upgrades are also available.  

http://www.sbc-support.ch/�
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2 PG5 V2.0.220 
 
The PG5 2.0.220 is a maintenance version setup to release improvements and corrections that 
have been done for PG5 2.0.200 and PG5 2.0.210. This version is fully upward-compatible with 
the PG5 2.0.200 and 2.0.210. 
 
In the following, you will find a list of the main features and corrections concerning the PG5 and 
the Web Editor.

 
 

2.1 PG5  
 

Saia Project Manager (SPM): 
 When restoring a project, remove dangerous download option 'Download after successful 

build'. 
 Update ‘Listing’ and ‘Documentation’ branches when Program File is deleted. 
 Better handling for libraries which are not in the Libraries or Projects directories. 

 
Fupla:   

 When updating an FBox, the output connections are now correctly defined; in some 
cases the connections were lost. 

 A new option is available for selecting the first static symbol, the group or no symbol 
selection when a FBox is selected. 

 The loading of Fupla files has been improved in order to better handle file corruption. 
 Corrections regarding Chinese characters. 
 In some case the invert connector was removed when a connection label was moved, this 

is now handled correctly. 
 In the page import dialog, the symbols for the connection labels are not displayed and the 

update of symbols and symbol scopes is correctly handled when switching to another tab.  
 Several corrections in order to improve the stability. 

 
FBox libraries: 

 SfupBase, version V2.6.213:  
o PWM FBox for PCD1.M2xx0 support also PCD1.M2160. 

 EIB,  version V2.6.220: 
o IP address and port are online adjustable on the EIB/IP driver, corrections on the 

FT1.2 driver and add help in Italian. 
 Room_L79x, version V2.6.130: 

o New FBoxes in order to support the new compact single room controllers 
PCD7.L79xN. 

 EnOcean, version SP2.6.147: 
o FBox Receive (any): order of output connector Data 0..4 inverted 
o Added FBox Sensortec 7x0 EVC  

 
IL Editor: 

 Splitter window is restored. 
 Ensure IL editor window keeps the focus after drag-and-drop from Symbol Editor. 

 
Graftec:  

 In some cases, Graftec was hanging when opening ST/TR containing IL code. This is 
now corrected. 

 
Symbol Editor: 

 In the DB Edit dialog, improve the keyboard handling. 
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 The '_ArraySize_' symbols are now correctly generated. 
 Several corrections in order to improve the symbol handling and the stability. 

 
Device Configurator: 

 PCD3.Compact: correction regarding the configuration of the digital input encoder. 
 PCD3.A810: correction regarding the upload of the configuration. 
 For the PCD2.M480, the minimum baud rate on serial and modem is 1200. 
 Add DALI Master communication module PCD2.F2610 and PCD3.F261. 
 

Watch Window: 
 Correction to the reading of inputs and outputs, so the reading sequence for H-modules is 

not disturbed. 
 
Ethernet RIO:  

 When switching from programmed to un-programmed RIO, the program is now removed. 
(But the program files remain, so they are restored if it is set back to "programmed".) 

 Enhancement for the support of the PCD3.B100 module and improvements in the build in 
case of RIO parameter change.  

 
Up/Downloader:  

 Fix problem regarding self-downloading files. 
 Update memory allocation to handle new PCD Firmware which does not subtract the 

"extension memory backup size" from the code/text memory size. 
 
Assembler: 

 Put comment ;{F} in _Global.sy5 file for float values, needed by OPC server. 
 
BACnet Configurator and compiler:  

 The device and object tree is now always expanded at start-up. 
 Corrections and improvements regarding unit indexes, min and max values for integer 

types and the program object. 
 
LON/IP Configurator: 

 Add possibility to configure network settings. 
 Corrections and improvements regarding union handling, index handling and symbol 

length checks. 
 

FBox Builder:  
 Corrections and improvements in the build, when creating an FBox from a Fupla page, in 

the find dialog box, in the syntax colouring and in the help.  
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2.2 Web Editor  
 

Modifications/corrections regarding the Web-Editor: 
 

 TEQ views containing Macros were not displayed and the Micro-Browser Web panel crashed under 
certain circumstances. This was due to a bug in the Web-Editor Version 5.15.02 when Macros with 
version 5.14.30 or higher had been inserted in a TEQ view. 

 
 When using the macros “AlarmingDefOnline_5_15_02xx” and “AlarmingHisOffline_5_15_02xx”  

@PP0_Min_Max are not anymore inserted in the PPO list. 
 

 
 
 
 
 
 
 

 The "Select" button was missing in the cross ref's Macro find replace dialog. 
 

 Now a warning dialog is generated when the user opens a project where BROADCAST ACTION 
mode was defined. This mode is no longer supported from the client. The project will be converted 
(force to CONSUMED ACTION mode), else the project will open in read only mode. 

 
 PLC Editor modify Font Generator so now forces non anti-alias parameter during font generation, 

and modify fontconfig.txt so default generated chars are ASCII printable (char between 0x21 0x7E). 
 

Modifications/corrections regarding the IMaster applet: 
 

 The first HTML TAG in the language file (*.CSV) was not displayed in the PC Browser (IMaster 
applet) when the file was saved as Unicode file.  

 
 xx7 Offline trends were not displayed in the PC Browser (IMasterxx7 applet). 

 
 IMaster applet now warns the user if BROADCAST ACTION mode was defined in HMI that this 

mode is not supported anymore. 
 

 IMaster now updates @CURRENT_PAGE container on teq jump if loading mode is not equal 
“standard load mode”. 

 
 IMaster resolving PPO name of type "@COFF_xxx@.a/b,d" so uses ".a/b,d" as PPO end name. 
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 The loading messages during applet initialization can now be disabled or adapted according to user 

preferences by defining a new HTML TAG "InitPhaseMessagesLevel" in the HTML file. 
 
 
 
 
 
 
 
 
 
 
 
    
The following HTML-Tag line can be added in the projects html file in the section which is not 
overwritten by a build of the Web-Editor project. 
 
<PARAM NAME="InitPhaseMessagesLevel" VALUE="2"> 
 
The following values can be used: 
 
0 ==> No init phase message displayed  
1 ==> ALL init phase loading filexx messages are displayed  
2 ==> Only message text "Loading..." is displayed at init phase  
3 ==> loads an image and displays that image during init phase (the loading image may also slow 
down if a bigger image is used) 
 
If the Option 3 is selected, the image file name can be defined by the following parameter: 
 
<PARAM NAME=”initPhaseMessagesLevelImageDisplayName” VALUE=”filename”> 
 
 
 
 

2.3 More information 
 
For more details and to find the complete list of corrections and enhancements, please, refer to 
the document 'Release notes PG5 V2.0.220.txt' define in the installation directory of PG5, 
typically 'C:\Program Files\Saia-Burgess\PG5_20\Release notes PG5 V 2.0.220.txt’ 
 

 

L
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3 PG5 V2.0.210 
 
The PG5 2.0.210 is a maintenance version setup to release improvements and corrections that 
have been done for PG5 2.0.200. This version is fully compatible with the PG5 2.0.200.  
In the following, you will find a list of the main features and corrections: 

Ethernet RIO:  

 Diagnostic flags are now correctly mapped (‘RIO.ManagerNotPresent’).  
 Correction concerning the renaming of RIO device (update symbols).  

 
Fupla: 

 Correction concerning the importation of templates (static symbols are visible).  
 Improvements and corrections concerning to support the Cyrillic.  
 Several corrections in order to improve the stability.  

 
IL Editor: 

 Correction in order to open the ‘*.inc’ files.  
 
Graftec:  

 Several corrections in order to improve the stability.  
 Improve the error message handling.  
 Improve the behaviour of the renumber ST/TR functionality.  

 
Device Configurator: 

 Add support for PCD1.M2160.  
 Corrections concerning the time zone. 
 Improvement of the upload of the IP settings.  

 
FBox libraries:  

 The library 'Room L79x V2.6.121' and 'EnOcean SP2.6.130' are now installed.  
 Corrections have been done in the help of several libraries (image missing).  

 
Downloader:  

 Better handling for the downloading of large Web Editor projects into PCD1.M2 and 
PCD3+ devices (no NAK response).  

 
Web Editor:  

 Some improvement and corrections regarding the online alarming macro, the ‘Select’ 
button in the ‘Macro Find/Replace’ dialog and other functionality.  

 
BACnet Configurator and compiler:  

 Corrections and improvements regarding the loop object and the count of input 
references.  

 
DDC Add-on:  

 Generates error message in case of duplicated web alarming texts.  
 
FBox Builder:  

 Improvements and corrections concerning for the support of Cyrillic.  
 
For more details and to find the complete list of corrections and enhancements, please, refer to 
the document 'Release notes PG5 V2.0.210.txt' define in the installation directory of PG5, 
typically 'C:\Program Files\Saia-Burgess\PG5_20\Release notes PG5 V 2.0.210.txt’ 
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4 Service Pack 2 for PG5 2.0 (version SP.2.0.200) 
 

4.1 Installation 

4.1.1 Supported operating systems 
 
This PG5 version supports the following operating systems: Windows XP, Vista 32/64 bits and 
Windows 7 32/64 bits. 
 
Microsoft .Net 2.0 must be installed on Windows XP operating system. 
.Net installer is available on the installation disk: ‘<DVD drive>:\Windows\ dotnetfx_2_0.exe’. 
 
Note: It is possible to install PG5 2.0 on Windows Server 2003 and Windows Server 2008, but we 
do not get any guaranty about the functionality because we do not have make tests on those 
versions. 

4.1.2 Setup 32 and 64 bits 
 
Our installers are improved to insure the full compatibility with 64-bit operating systems. 
 
According the target operating system, 32 or 64 bits, the installers are indexed with ‘x32’ or ‘x64’. 
Exemple: ‘Setup PG5 Suite V2.0 x32.exe’ or ‘Setup PG5 Suite V2.0 x64.exe’. 
 
The installers without index are supported by all the operating systems, 32 and 64 bits. For 
example: ‘Setup Web Editor V2.0.exe’. 
 

4.1.3 New Saia USB driver 
 
This new service pack installs a new USB driver compatible for Windows 32 and 64 bits. 
 
The new SAIA USB driver replaces the older version and is compatible with older version of PG5 
2.0. 
 
For PG5 1.4.300, the SCOMM has to be updated in order to be compatible with this new USB 
driver. The patch is available in the PG5 installation DVD, under the following folder: 
 
‘<DVD drive>:\SComm update for PG5 SP14300 \SCommUpdate_1.4_320.exe’. 
 
If you have troubleshooting when connected a PCD on your PC, you will find more information in 
the following document: 
 
‘<DVD drive>:\SComm update for PG5 SP14300 \SaiaUSB Info & Installation.pdf’. 
 
It will explain how to force the update of the USB driver with the corresponding version and how to 
proceed if you are using the USB driver for XX7 systems. 

 

4.1.4 Setup programs and upgrades 
 
The same program setup can be used to the first installation on a clean computer or to update the 
current software version with a more recent version. It is no longer necessary to uninstall the 
previous version before starting the new setup.  



Saia-Burgess Controls AG                                                                  PG5 2.0 What’s New 

20/03/2012/1:30 PM                                                                                                                    Page 13 of 108 

 
The new 'Quick Patches' feature lets you install small PG5 updates quickly and easily: 
 
 The existing version is checked before the patch is installed. If the patch does not match the 

installed PG5 version then an error message is displayed and the patch is not installed. 
 
 The patch is integrated to the program maintenance. If a patch has been installed, the 

'Repair' or 'Modify program' options from 'Control panel / Add remove Programs' do not 
remove the patched files. 

 
 
 
 

4.2 Ethernet RIO 
 
The smart RIOs extends the PCD3 system family and enables efficient decentralization of 
automation tasks. They have unique functional features and so stand out from traditional remote 
I/O systems not only in functionality but also in terms of programming, commissioning and 
service. 
 
They are functional traditional remote I/Os and can simultaneously execute PG5 application 
programs (IL, FUPLA, GRAFTEC). By this even demanding tasks can be carried out directly in 
the S-RIO. In depended of the Smart Automation Manager, the (sub-) process continues 
respectively can be controlled by the S-RIO in a safe state. The central management of the 
application programs in the Smart Automation Manager saves costs for programming, 
commissioning and service. 

 

4.2.1 Product description 
 
The S-RIO stations are not just remote I/O stations; they also have PLC functionality and so can 
remotely and autonomously process user programs (IL, Fupla, Graftec). Complex and critical 
tasks can then be handled directly within the RIO. If the RIO manager (master) fails, the (sub-) 
process continues to run, or it can be brought to a secure state by the S-RIO. Fast process can 
be monitored remotely by the two interrupt inputs, for example, analysed directly in the S-RIO and 
then processed further. Even complex and time-critical control algorithms can be run directly in 
the S-RIO. 
 
 
For the data exchange the Ether-S-IO protocol, which is optimised for distributed I/O, is used. 
Data transfer between Manager and RIO can be configured with just a few mouse clicks in the S-
RIO Network Configurator. Once the configuration has been loaded into the manager station, the 
operating system carries out the data transfer autonomously in the background. No additional 
programming by the user is necessary.  
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The Manager sends periodic broadcast and/or unicast telegrams to the S-RIOs to update their 
outputs. The use of broadcast telegrams significantly reduces data traffic across the network. At 
the same time, the S-RIOs also send the input states to the manager on a periodic basis. This 
relieves the manager of communication tasks. The cycle times can be individually configured for 
each station or even for each telegram. Time-critical processes or signals can then be prioritised. 
 

4.2.2 Configuration with the new RIO Configurator 
 

The configuration and programming of the new smart RIOs is fully supported in the new version 
of PG5 2.0. 
 
In order to enable the configuration of smart RIOs, a new device in the Project Manager has to be 
defined. This device will be the manager of the RIO network. The manager functionality can be 
enabled using the Device Configurator, selecting the ‘Ethernet’ slot and setting the ‘Ethernet RIO 
Network’ property to ‘Smart RIO (PCD3.T665/T666)’. 
 

 
 
 
Note: S-Bus RIOs – PCD3.T660 – are still supported under PG5, but you can not mix both 
version inside the same PG5 project. In order to define a new project with S-Bus RIO, select the 
‘Ethernet’ slot and set the ‘Ethernet RIO Network’ property to ‘S-Bus RIO (PCD3.T660)’. 
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After saving the configuration of the manager, a new entry – ‘Ethernet Smart RIO Network’ – will 
be displayed in the project tree. 
 

 
 
It is now possible to define RIO devices into the project with a double click on the ‘RIO Network 
Configurator’ item. The double click will open the ‘RIO Network Configurator’. This is a new 
configurator especially developed for configuring the Smart RIOs. New RIO devices can be added 
using the ‘New RIO …’ command from the ‘RIO’ menu. 
 
A dialog will be displayed in order to set the RIO name, a description, the IP address and define if 
the RIO will have a program or not. 
 
The device will be then displayed in the RIO Network Configurator window.  
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The first view of the Configurator is the ‘Network’ view. It displays all the defined RIOs, with their 
properties, like name, IP address, type… The second view of the Configurator is the 'Media 
Mapping' view where all media mapping symbols are displayed and can be edited. 
 
The transfer of the input values from the RIO to the manager is done in 2 steps.  
 
The first step is the transfer of the input value from the input card to the RIO media (flags or 
registers) using the media mapping. This first transfer is automatically done using the Device 
Configurator, in placing the IO modules into the RIO slots. There is no need to enable the media 
mapping and defining the media addresses; this is done automatically. In order to define the IO 
module for the RIO, double click on the selected RIO in the ‘Network’ view of the RIO 
Configurator; this will open the Device Configurator displaying the settings of the selected RIO. At 
this point, the RIO type – PCD3.T665 or PCD.T666 – can be selected. 
 
The second step is the transfer of the input values, mapped on registers or flags, from the RIO to 
the manager. This second transfer is also defined automatically using the media mapping view of 
the RIO Network Configurator. The value are transferred as arrays, for better performance, and 
are mapped in the manager media – flags or registers. The media mapping view displays the 
media information for each transfer, corresponding to the slot of the RIO. The symbol names can 
be defined and the address of the array can be specified or let blank for dynamic addressing. It is 
also possible to set the transfer rate or disable the transfer. 
 
For transferring the output values from the manager to the RIO, the mechanism is the same, first 
transfer the media – flags or registers - from the manager to the RIO and then transfer the output 
values from the RIO media – flag or register – to the output modules using the media mapping. 
 
For programmable RIO, it is possible to define new transfer arrays in order to transfer RIO 
program data – registers or flags - into the manager or from the manager to the RIO program 
data. 

 
Once the configuration is done, the manager program can be built and downloaded into the 
manager PCD. Download into the RIO is not nedde, the manager will do it. The only configuration 
at the RIO level is setting the IP parameters – IP address, subnet mask, default router. This 
configuration can be done directly from the Device Configurator over the USB connection, using 
the ‘Download Configuration …’ command from the ‘Online’ menu. Another way to configure the 
IP parameters is to use Web Connect, define a USB connection and access the web page 
displaying the RIO status. 

 
As mentioned before, the RIO can have a program. For enabling RIO to have program, the option 
‘Has Program’ in the ‘RIO Properties’ window has to be set. 
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Then the programmable RIO will appear in the ‘Project Manager’ tree, under the manager, as a 
standard device. 

 

 
 
From there, you can add program files to the RIO, as for a PCD device – Fupla, IL, Graftec. User 
program data exchange between RIO and manager can be define using the RIO Network 
Configurator, selecting the corresponding RIO in the ‘Media Mapping’ view and selecting the ‘New 
Data Transfer Array …’ command of the context menu. 
 

 
 
The transfer array can be specified by selecting the transfer direction, the data type, the size and 
the symbol name. Once done the transfer will be displayed in the ‘Media Mapping’ view, under the 
corresponding RIO. 
 
It is not required to build and download each user program to each RIO separately. A build and a 
download at the manager level will automatically build the RIO user program. The manager 
program and the user program will automatically be downloaded into the manager. The manager 
then will transmit the user program to each RIO and then start the data transfer automatically.
  
Diagnostic informations such as transmission failure, lost of telegrams, status of each RIO, are 
available at the manager side. The informations are mapped to flags and are displayed in the 
‘Media Mapping’ view of the RIO Network Configurator. 
For RIOs having program, diagnostic flags are automatically defined and displayed in the ‘All 
Publics’ view of the Symbol Editor in order to be used in the RIO program for checking the 
communication status with the manager. 
 

4.2.3 More information: quick start document, sample projects and help 
 
For more information, a quick start document is available on the PG5 DVD: 
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‘<DVD drive>:\PG5 Samples\PG5_2_0_GettingStarted Rio Ethernet\Quickstart_PCD3T66x.pdf’ 
 
The PG5 demo projects ‘RIO Exercise 1’ and ‘RIO Exercise 2’ are available on the PG5 DVD: 
‘<DVD drive>:\PG5 Samples\PG5_2_0_GettingStarted Rio Ethernet’ 
 
The help of the RIO Configurator contains a full description of the RIO functionalities. Do not 
hesitate to check this help if you have questions or problems. 
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4.3 Device Configurator 

4.3.1 New I/O media mapping window 
 
The new Media Mapping view shows the symbol names for all I/Os which are mapped to media - 
registers and flags. The view can be shown or hidden using the "View / Media Mapping" menu 

command or click on this icon in the task bar:  
 
The addresses for the input and output symbols can be dynamic or absolute. It is no longer 
necessary to define consecutive addresses as array of symbols, except for RIO media or for older 
firmware version – see the point ‘Media mapping and Firmware version’ below in this document. 
 
The media mapping supports external symbols which are defined in other files with ‘Public’ scope 
(Fupla, IL or symbol files). These can be filled in quickly using drag-and-drop from the Symbol 
Editor. If you have defined a Fupla application where some public symbols need to be link to an 
input or output, just drag-and-drop them into the Media Mapping view, in the corresponding input 
or output symbol line. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
A context menu helps changing configuration for the entire device, selected slots, or selected 
media. The context menu allows: 

 Enable or disable the media mapping for each module. 
 Renumber addresses used by the media mapping, absolute or dynamic. 
 Reset symbols to the default name. 
 Change media type between Flag and Register when modules allow it. 
 Cut, copy, paste and delete. 
 Select all, expand all and collapse all. 
 Add to ‘Watch Window’. 
 

The Media Mapping table can be copy/pasted from/to an ‘Excel’ table. This functionality is useful 
for importing or exporting the data point information directly into the PG5 project. 
 
During development, you will need to rename symbols which may be used in several editors 
(Fupla, IL or Graftec). Now you can rename a public symbol's references in all editors at one time. 
If public symbol names (I/O symbols) are renamed in the Media mapping view, when you save 

PLC node description 

Slot node description 

Mapping N°0 disabled 

Mapping N°1 enabled, dynamic base address 

Media mapped ref. the base 

Media mapped ref. a global symbol 

Media mapped to fixed address 

Media mapped to dynamic address 

Mapped to fixed address without symbol 

No media mapped, data accessible in 
peripheral memory by IL code 

Mapping N°2 enable ref. a global symbol 

Media mapped to external symbol 

Mapping N°3 enable with fixed base address 
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the file the ‘Rename Public Symbol References’ dialog box is displayed which lets you choose 
which symbols will be renamed in other Fupla, IL or Graftec files. 

4.3.2 What is IO Handling and Media Mapping? 
 
"I/O handling" transfers analogue or digital values from input module to a memory buffer called 
Peripheral Memory, or writes analogue or digital values from the Peripheral Memory to output 
modules. Peripheral Memory can be read or written using IL instructions (RDP, WRP). Constant 
symbols are created automatically by the Device Configurator in order have access to the data in 
Peripheral Memory. 
 
"Media mapping" is a way to automatically transfer input data from the Peripheral Memory to 
register or flags and to transfer output data from flags or registers into the Peripheral Memory. 
The media mapping allows an easy access of input or output values by the user program. The 
values of input data are updated at the beginning of each program cycle and the output values 
are updated at the end of each program cycle. This functionality is especially useful for analogue 
input and output modules - it is no more necessary to use FBoxes or FBs to read or write 
analogue values. 
 
Media mapping is available for most PCD devices, but it is not mandatory. The program can 
either read or write the inputs and outputs directly, or use the Peripheral Memory. 
 
For some new devices like the PCD1.M2, the PCD3 Wide Area Series and PCD3 Compact 
Series, the media mapping must be configured in order to have access to the onboard IO. 
 
In order to configure the Media Mapping: 
 Open the Device Configurator from the Project Manager 
 Select the Device type 
 Select the main slot of the device; check that IO Handling is active 
 Fill in the I/O slots with modules from  the ‘Selector Window’ 
 Enable the Media Mapping for each module, and set the properties for the analogue inputs or 

outputs 
 Open the ‘Media Mapping View’ and modify the symbol names 
 Save the configuration 

4.3.3 Media mapping and Firmware version 
 
Firmware before 1.16.00 requires all media to be mapped as arrays. But new firmware allows the 
mapped media to be separate addresses – but this is slightly slower than if arrays are used. If 
using dynamic addresses, offsets from a dynamic base array should still be used – do not use 
separate dynamic addresses for each media because it is less efficient. 
 
Note: When changing the firmware version from 1.16.xx to older versions, the symbols 
configuration will be automatically adapted to the array configuration. It means that if you have 
defined specific addresses or array of addresses, they will be automatically replaced by the 
standard array definition, according the old media mapping transfer – based on arrays. 
 

4.3.4 Ethernet communication / protocols 
 
For a better organization, DHCP protocol parameters move from “IP Protocols” to “Ethernet” 
section. And “Ether-S-Bus” parameters were moved out from the “TCP/IP” parameters. 
 
Now, TCP/IP protocol is enabled by default. The “IP Address” and “Default Router” has to be 
configured or “DHCP Client” enabled to have a working protocols. 
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New parameters are available to configure Portal parameters, under the ‘Ethernet 
Communication’ slot. The Http Portal communication protocol for PCD allows communication over 
private network.  
 

4.3.5 Support for new devices / modules 
 

The following new devices and modules are now integrated into the Device Configurator: 
 
 PCD3.T665/6: Ethernet RIO devices, see Ethernet RIO. 
 PCD1.M2020: same controller as PCD1.M2120, but without Ethernet communication port. 
 PCD2.C1000: expansion module with 4 I/O slots and 24V power supply. 
 PCD2.B160 and PCD3.B160: 16 combined inputs or outputs module. 
 PCD2.F2710 / PCD3.F271: M-Bus master module for communication with up to 20 slaves.  
 PCD2.F2720 / PCD3.F272: M-Bus master module for communication with up to 60 slaves. 
 PCD2.F2730 / PCD3.F273: M-Bus master module for communication with up to 120 slaves. 
 PCD3/7.R580 / PCD3/7.R581: flash memory card with LON/IP firmware. 

 

4.3.6 Label Editor for PCD1 
 
The Label Editor, included in the Device Configurator, has been updated in order to define and 
print labels for the PCD1.M2xx0. It is possible to define labels for the onboard inputs and outputs 
and for the 2 configurable input or output slots. 
 
The Label Editor allows you to define and print inputs and outputs labels for the PCD2 devices 
and expansions, for the PCD3 modules and for the PCD1.M2xx0 devices. The Label Editor is 
accessible from the Device Configurator using the command ‘Label Editor’ under the ‘Tools’ 
menu. 
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4.4 Saia Project Manager 

4.4.1 Program version 
 
A program version text can be entered in the Device Properties dialog box. This is shown in the 
online Program Information dialog box, see below. The version can be any text, but if it is a valid 
version number, it also creates a symbol which can be used in the program.  
 

 
 
 

4.4.2 Program information 
 
The Project Manager command ‘Online, Information…' displays information about the active PG5 
program and the program in the connected PCD. It also compares the information and indicates if 
the programs are different. This is also available from the Online Configurator, but it shows only 
the information from the connected PCD. 
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According the comparison of this information, a status indicates if the project and the device files 
are the same or different: 

 Files and PCD programs are the same 
 Files and PCD programs are different 

 
 
The program information parameters can be mapped to text variables in user program. In this 
way, it will be also possible to display the program information into web pages.  
 
In order to mapped the information into text variables, the ‘@STR()’ command has to be used in 
the text declaration, as below: 
 
DeviceName  EQU TEXT 
TEXT ProgramName  “@STR(S.STR.DeviceName)” 
 
ProgramVersion EQU TEXT 
TEXT ProgramVersion “@STR(S.STR.ProgramVersion)” 
 
The following pre-defined system strings are pre-defined: 
 
S.STR.PG5RegisteredUser: Registered user name of Saia PG5 package  
S.STR.PCUserName:  Name of the user who is logged onto the PC.  
S.STR.PG5Version:  Version number of PG5, e.g. "2.0.100"  
S.STR.ProjectName:  Name of the project  
S.STR.DeviceName:  Name of the device (program name)  
S.STR.PcdType:  PCD type, e.g. "PCD3.M5540"  
S.STR.ProgramVersion: Program version from Device Properties dialog box, e.g. "1.0"  
S.STR.ProgramID:  Unique program ID  
S.STR.FileName:  Name of the source file.  
 
You will find more information about the predefined string into the IL online help, by searching for 
"Strings”, “STR” and “@STR( )". 
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4.4.3 New download program dialog 
 
The ‘Download Program’ dialog box has been updated. It supports the new Flash Backup 
features, and some options have been moved to an ‘Advanced’ section. The Download Options 
have also been simplified, and are now configured for each device instead of globally for all 
devices. The default download options for new devices are configured from Project Manager's 
'Tools / Options…' dialog. 
 

 
 
 

 
 
 

4.4.4 New flash backup / restore functionality 
 
Project Manager's 'Online / Flash Memory…' commands have been updated to support the 
features of the new firmware. The destination flash card can be chosen. Depending on the flash 
card type, PCD type or FW version, the backup format (File or Image) can be selected. There is 
also a new Delete Backup From Flash command. 
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4.4.5 Pre and post build scripts 
 
Project Manager can now run a batch file before starting a build and after the end of the build. 
These batch files can be edited and enabled using the new 'Device / Advanced > Pre-build Script' 
and 'Post-build Script' commands. 
 

 
 
This new feature can be used for example for making automatic source backup on each build. 
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4.4.6 Windows 7 Jump List 
 
If you have pinned the PG5 application into your Windows 7 taskbar, you can benefit from the 
new PG5 jump list. In right clicking on the PG5 icon, the PG5 jump list will be display and you can 
then directly open one of the last open PG5 project, directly open the Online Debugger, the 
Firmware Downloader, the Web Connect or other application – see the picture below. 
 

 
 
 

 

4.4.7 New build option for PCD1.M2xx0 and PCD3.Mxx60 
 
The build ‘First writable Text/DB number’ option has to be defined for PCD1.M2xx0 and 
PCD3.Mxx60. Texts and DBs below this address are read-only. You can set 0 to allow all Texts 
and DBs to be writeable. This value must always be less than the lowest RAM Text and RAM DB 
address.  
 
By default, Texts and DBs below 4000 are read-only (these are in Flash or EPROM memory), and 
Texts/DBs from 4000 and above are writeable (these are in RAM).  
 
For the new PCD1.M2xx0 and PCD3.Mxx60 models, this partition can be configured for the user 
program to run if it was developed on a PCD which had RAM for Texts/DBs below 4000. Note that 
the amount of RAM for Text/DBs is limited, and in large programs it may not be possible to have 
all Texts/DBs in RAM. 
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4.5 Fupla Editor 

4.5.1 Fupla Unicode 
 
The integrated Symbol Editor was able to work only with the ANSI 1252 character table. Because 
the files are saved also with this character set, the special characters were lost. Now the user can 
specify the used character table, for a new file it will be detected automatically based on the 
default settings of the OS. To set or check the Codepage select the Properties from The File 
menu: 
 

 
 
This makes it possible to read the page on any computer even if it uses different codepage. 
 
Note: The fonts for the corresponding codepage have to be installed; otherwise the special 
characters in the connector or in the tooltip will not be correctly displayed. 
 
It can be useful to set a specific code page when you have to make a PG5 project that has to be 
compiled in on a Russian operating system. All you have to do is to specify a Russian keyboard in 
your English operating system and specify the code page in the Fupla file. You will be able to 
enter Cyrillic characters in your Fupla file. If you transfer the project into a PC with Cyrillic 
operating system, the special character will be recognized and your Fupla file will be compatible. 
 
Note: The Unicode functionality is implemented only for Fupla. If you are using S-Edit or Graftec, 
the special character maybe not displayed correctly.  
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4.5.2 Logging of FBox adjust parameters 
 
The logging of FBox adjust parameters allows to log and retrieve the Fupla FBox adjust 
parameter changes when you are online with the Fupla file.  
 
Start logging: 
 
To enable the logging, you have to open the Fupla file, then display the property of the current file 
using the menu ‘File’ > ‘Properties’ command. Then, in the property window, set the ‘Log Online 
Changes’ to ‘Yes’ - see previous topic for the picture. 
 
When it is enabled, when you will be online with the corresponding Fupla file, each change of the 
adjust values is logged into a file. The log file is text based and contains the following information: 

 date 
 time 
 user name (PC user name) 
 adjust parameter identification (Fupla page, FBox identifier, parameter identifier) 
 adjust parameter old and new value (as value and as string) 

 
The changes are appended to the end of file until the option is enabled. 
 
Another way to enabling the log is to set the Fupla file, the Device or the project as read-only. 
This can be done from the Project Manager, using the context menu off the project tree and select 
the ‘Properties …’ command, then the property ‘Read-only’ can be checked in the property dialog 
box. 
 
Update Fupla file with logged data: 
 
At the end of a log, the adjust parameter values can be written back to the Fupla file. In order to 
make this update, set the file property ‘Log Online Changes’ to ‘No’. Then close the Fupla file and 
re-open it. Then Fupla checks for the log file and once the Fupla file loaded, the following dialog 
will be displayed with the list of changes logged into the file: 
 

 
 
For a better overview of the parameters that have been logged, a double click on a line will select 
the corresponding FBox in the specific Fupla page. 
 
In order to update the adjust parameter into the Fupla file, just check the box in the grid. The 
source will be updated with the selected changes and the list of the updated values will be 
displayed in Message Window : 
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Then the log file will be deleted. 
 
When the log is enabled after setting the read-only property, the ‘Online Parameter Change List’ 
dialog will be displayed the next time the Fupla file will be opened in read-write mode. 
 
 

4.5.3 FBox classification view 
 
The FBox Selector window has been updated with a new FBox classification. This new 
classification is based on the FBox functionality and can have more than on level – see the 
picture below. In this new classification, the FBoxes are no more grouped by libraries. 

 

 
 
The original FBoxes sorting, based on libraries, can be restored using the context menu ‘Group 
By Function’. 
 
You will find more information under the ‘FBox’ part, below in the document. 
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4.5.4 Improved cross-reference handling: search, print 
 
Cross reference inside Fupla makes possible to find the place where the FBoxes or symbols are 
used. For big projects, this list can be long. In order to simplify the handling, a ‘Find’ functionality 
has been implemented in order to find an item in the reference list.  
  
The reference list can be also added into the printed documentation; select the ‘Symbol 
Reference List’ in the Print Options: 
 

 
 
The cross-reference list can be also exported to a text file containing all the information displayed 
on the tree view using the command ‘Export List…’ from context menu. 
 
The search function in Fupla can be now found under the ‘Edit’ menu > ‘Find’ command. It can 
search for names and comments of symbols, FBox names and comments, free comments texts in 
page, in page name, description and comments and in block names and comments. 
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4.5.5 Import pages 
 
During page import only the selected pages are imported, until now it was connected to the 
selected state of the items in the list view.  
To simplify the selection and make it easier to see the selected pages the ‘Page Range’ list is 
updated with checkboxes. Using the checkbox in the column header, every page can be selected 
/ unselected. 
 
 

 
 

4.5.6 Others 
 

Online probes:  
 
Improvements in the context menu in order to save the default format and the default position 
without additional dialog box. 

 
Property grid:  

 
Easier navigation in the property grid - editing FBox adjust parameters is as simple as it was 
with the old adjust window, just press tab to jump to the next editable field. 
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4.6 Symbol Editor 

4.6.1 Editing in filtered views 
 
Now it is possible to select a subset of symbols with user defined filters and edit them – except 
the value used for filtering 
 

 
 

4.6.2 Stretch over groups 
 
The stretching is working by default inside the group – can assign the same property to the 
symbols only in the same group. In the Symbol Editor, the option ‘Stretching over groups’ can be 
enabled in order to use stretching independently from the owner group of the symbol. In this way, 
a tag can be assigned to several symbols, independently of the groups. The option can be set 
from the Symbol Editor context menu, ‘Advanced’ > ‘Options …’. 
 

4.6.3 Speed improvements 
 
We have worked on Fupla Editor in order to speed up the opening of the files. Comparing to the 
previous release (SP 2.0.150), the big Fupla files can be now opened about 30% faster. 
 
To minimize the time to wait until the editor started the following optimizations have been 
implemented: 
 

 Library cache in Fupla: There are hundreds of FBoxes families loaded by every start-up; 
a cache file makes now possible to load them up to 3 times faster. The files are created at 
the first start and updated every time when a newer version of the library is detected. 

 Delayed load of FBoxes in FBox Selector view: the FBox items in the FBox Selector 
are uploaded only when they are activated at the first time – it can spare up to 3 seconds 
at every start-up 

 Reference list in Fupla: The reference list is only created and displayed when the list is 
displayed, as default by the start-up it is always turned off  - depending from the project 
size seconds can be spared. 

 Symbol lists in Symbol Editor: mminimized loading time of the symbols from the ‘pcd’ 
file to display the in the All Publics list and update the addresses of the local declared 
symbols. 

  
Note: It is also possible to speed up the opening time of a source file by disabling the background 
build – in the Project Manager, menu ‘Tools’ > ‘Options’, then set the property ‘Background build’ 
to ‘No’. In this case, the ‘All Public’ and the ‘System’ views in the Symbol Editor are only updated 
after a build. In this case, the symbol views will not be updated after opening a file or saving a file. 
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4.7 Instruction List Editor (S-Edit) 

4.7.1 Add Externals to Symbol Editor command 
 
To reference Public symbols which are defined in other program files, an External declaration is 
needed (unless the Public symbol is in a Global Symbol File). Without the External declaration, 
the build will generate 'symbol not defined' errors. 
When a new IL line which contains a symbols is typed and Enter is pressed at the end of the line, 
S-Edit looks in the All Publics page of Symbol Editor. It if finds a matching public symbol, then it 
will add an External reference to the Symbol Editor page of the open file.  
However, this does not work if code or symbols are copy/pasted into the S-Edit document, or if 
Enter is not used to end the line. In this case the new 'Add Externals to Symbol Editor' command 
on the Tools menu can be used to process the entire file, or the marked text, to add the External 
references.  
There is also a shortcut key Ctrl+Q which will add the symbol or type/address under the caret to 
the Symbol Editor.  
(Note: As with PG5 V1,.x, symbols in Global Symbol Files, e.g. Global.sy5, do not need External 
references. If present, they are ignored.) 
 
 
 

4.8 Web-Editor Release 5.15.02 
 

4.8.1 Enhancements 
 
This version 5.15.02 includes the following major enhancements: 
 
 Alarming 2 functions 
 New S-Web Templates and Icon Gallery 
 User entries in the HTML file 
 STEP7 Symbol import 
 HDLog for xx7 
 More new features and bug corrections… 
 

4.8.2 Alarming 2 functions 
 
The Alarming modules have been enhanced with powerful functions which are provided in form of 
new FBoxes and Web Macros. The old functions are still available and can be used without any 
change. 
 
New ‘Alarming 2’ macros 
 
 
The following macros support now the new macro configuration dialog: 
 
 MacroAlarmingDefOnline_5_15_01.esm 
 MacroAlarmingHisOnline_5_15_01.esm 
 MacroAlarmingHisOffline_5_15_01.esm 
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The alarms can now be assigned to priorities and groups. 
 

 
 
The alarm texts can now be displayed on one or two lines. In addition for each alarm an individual 
help text can be displayed. 
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Event list 
 
In addition to the existing Alarming functions there is now the new Event list. In the event list all 
alarm events (on, off, ack, delete, etc.) are logged chronological with status indication and time 
stamp. The list can be extended to CSV files on flash memory. 
 

 
 

Alarming 2 FBoxes 

 
The Alarming 2 functions are supported  
with the following new FBox: 
 

  
 
 
The new FBox is available from library  
version 2.6.164. 
 

PCD firmware versions 

The following versions support the  
Alarming 2 functions: 
PCD-NT systems PCD1.M2120,  
PCD2.M5540, PCD3.Mxxxx: from version  
1.16.27 
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Micro-Browser versions: 

 
Only with VGA and SVGA panels from version 1.16.26 
For more information, refer to the ‘Alarming 2 QuickStart Guide’ 
 
 

4.8.3 New S-Web templates and Icon Gallery 
 
The DDC Suite templates have been enhanced and are now in 4 languages (DE, EN, FR, NL) 
available. 
 

 
 
The new icons are provided in a separate library (Icon Gallery_V2) and can therefore also be 
used for other applications. 
 
For more information to the templates refer to the user documentation 
‘Grafiken_Handbuch_V2.ppt’, ‘07_1_DDC_Suite_Web_Vorlagen.ppt’, ‘Handbuch_Grafiken.ppt’. It 
is actually only available in German. Translations are in preparation. 

4.8.4 User entries in the HTML file 
 
Now the user can add own definitions (e.g. display format of the web page) in the HTML file. 
During Build in the Web-Editor the definitions are kept and not anymore overwritten. 
 
For more information, refer to the Web-Editor Online Help chapter ‘Special HTML Tags’. 
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4.8.5 STEP7 Symbol import 
 
With xx7 configuration of the Web-Editor STEP7 symbols can now be accessed from STEP7 project 
and used with the web project. 
 

 
 
For more information, refer to the Web-Editor Online Help chapter ‘xx7 Variable List Import’. 
 

4.8.6 HDLog to file for xx7 
 
The HDLog to file functions can now also be used with xx7 controllers. 
For more information, refer to the user documentation ‘HDLogFile for xx7’ and the user program 
example ‘HDLogFile Demo’. 
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4.8.7 Other new features 
 
New extended date and time formats for trending and alarming: 
 

 
 
IMaster load procedure: 
 

When opening a web page the IMaster displays now status information during the loading 
procedure. 
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4.8.8 Documentation and sample applications 
 
The online help is available in English and German. The correct language will be selected based 
on the installation of the Editor. New in the Online-Help all error messages and warnings are 
listed and explained. 
 
Together with PG5 Controls suite also the Web-Editor PDF help files are installed in German or 
English. 
 
Further information can be found in the Programming Guideline for the Web-Editor.  
 
The Programming Guideline describes the uses and functions of the Web-Editors by means of 
simple programming examples. The Guideline and PG5 programming examples are available on 
http://www.sbc-support.ch. 
 
 
 
 

http://www.sbc-support.ch/�
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4.9 FBoxes 

4.9.1 FBox classification 
 

Until now, the FBox libraries were classified according the family name. With this new PG5 
version, we introduce a new classification: the classification by function. This classification is more 
intuitive and it is easier to find the right FBox. 
 

 
 
 
The FBox Selector will show the new FBox organization by default, after the first installation. In 
using the 'Group By Function' context menu, it is possible to display back the old organization, 
based on the FBox libraries. 
 
The classification by function is more flexible. The FBoxes which are not classified with the right 
group can be moved to another group without affecting the library and the existing Fupla 
programs. 
 
Note: Libraries without function classification are displayed in the function view according the 
family names. This is not necessary to define a function group if the family name matches the 
function name; the family name is used by default. 
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Some details to understand the classification 
 

 The libraries are classified according the data type, hardware functionality or common 
functionalities. 

 
 FBoxes for manipulating data type are grouped inside the group of the same name: 

binary, integer, Data block, floating point, timer, counter, Block Control… 
 

 The common hardware functions are collected inside specific groups: Analogue I/O, 
Communication S-bus, Communication Text, Display module, Energy meter, File system, 
IP protocols, System information, Wide Area Automation… 

 
 The library formed by many families are collected in the same group: HVC, DDC Suite, 

Modbus, Modem, Room controller … 
 

 Families with many FBoxes are subdivided according functionality: the group 
communication S-Bus sorts the FBoxes into several subgroups and we can search for an 
FBox to initialise a communication canal (Ethernet, Profi-S-Bus …) or an FBox to receive 
or transmit data.  

 

4.9.2 Quick help 
 
Quick help is shown at the bottom of the Fupla FBox selector window. It shows useful data about 
the selected FBox: 
 

 The family and FBox name 
 The Library name and version 
 A short description of its function (the full description is still available by pressing F1) 
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4.9.3 New FBoxes  
 

 The Move binary, integer and floating FBoxes are now 
stretchable from 1 to 32.  

 

 
 

Complete the Neperian logarithm functions with two new 
FBoxes: 
  
Floating Point . Logarithm . Logarithm (Base 10) 
Outputs the logarithm base 10 of the input 
 
Floating Point . Logarithm . Exponent (Base 10) 
Outputs 10 to the power of the input: 
xy = 10 
 

 Floating-points . Arithmetic . Root/Power of X 
Outputs the  root or power of its inputs: 
           
Z = YX 
 

 

IP Protocols . DNS . Query IP Name 
Resolves the alphanumeric DNS name to an IP address. 
 

 

IP Protocols . SNTP . Status SNTP 
Retrieves the current execution parameters of the SNTP 
protocol, configured and started according to the loaded 
configuration parameters. 
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IP Protocols . SNTP . Reset SNTP 
Reset the SNTP process. Can be used if the FBox Status 
SNTP presents an error: no synchronization or lost of 
synchronization. 
 

 

IP Protocols . SNMP . Send Trap Bolean, Integer,           
Data Block 
Send a trap to the manager IP address & port configured by the 
Device Configurator or by the FBox. User information can be 
associated with the trap message. 
  
Traps are used to inform the manager that an anomaly or error 
is happen. (For sample, values which have reach or exceed the 
limit of use). 
 
The manager can then read the related value and eventually 
set a default one, protocol the anomaly,.. 

  
IP Protocols . Network administration . Ping 
Ping (Packet Internet Groper) is a network administration tool 
to check the Ethernet network connectivity and the remote 
device. It sends several packets at regular intervals to check if 
a remote machine is accessible and responding. The result of 
this test is available on the FBox outputs.  
 

 PWM outputs . PWM output 
Pulse With Modulation (PWM) is a technique commonly used to 
control an analogue signal from a binary one. These FBoxes 
are designed in order to work with the dedicated onboard PWM 
outputs 
 

 HVC . Init 
The adjust parameters initialization have be improved.  We 
recommend to use theses news FBoxes with your news and 
olds applications programs. 
 
The FBox Heavac 8 has no Reset input. It executes only 
automatic resets according to the predefined conditions. The 
Reset input is still available with an additional FBox, Heavac 
Reset. 
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4.10 DDC Add-on tool 
 
The DDC tools are now all integrated into a PG5 Add-on tool: the ‘DDC Suite’ add-on tool. When 
the DDC Suite add-on is installed, DDC suite file can be added into the PG5 project under the 
‘Program Files’ folder of devices using the context menu ‘New...’ then select the ‘DDC Suite 
(*.ddc)’ file type. The user interface comes with three main editing functions. 
 

 
 

4.10.1 BACnet 
 
The BACnet functionality of the DDC Suite add-on enables updating the BACnet configuration file 
‘*.bnt’ file with the BACnet configuration generated by the DDC suite FBoxes define in the Fupla 
files – the ‘DDC_BACnet.bnt’ file. This update can be done by clicking on the ‘Generate’ button. 
 
By selecting the ‘Force Update’ option, the old content of the BACnet configuration file will be 
cleared before the update with the BACnet configuration generated by the DDC FBoxes. To see 
what blocks have been updated, you may click on the "Open Log file" link. A text file will be 
displayed containing all the updated BACnet objects. 
 

4.10.2 HTM Doc 
 
The DDC Suite FBoxes are able to generate a documentation for the program that contains a 
general description and all actual adjust parameters for the used FBoxes. 
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The DDC Suite template project contains source files for the documentation feature in ‘htm’ 
format. It is possible to change these ‘htm’ files according to your needs. 
 
To be able to use these files, the HTM Doc function converts the ‘htm’ files into the ‘src’ format 
and copy's it to the CPU. Then at every build a fresh documentation is generated automatically. 
 

4.10.3 Alarming 
 
The DDC Suite FBoxes generate the ‘DDC_Alarming.csv’ file at every build. This file contains all 
alarm texts that are use inside FUPLA program. 
 
The Alarming addon tool merges the information of the ‘DDC_Alarming.csv’ file into the ‘csv’ file 
that is used by the Webeditor for the Alarming Macro – by default ‘SwebText.csv’. 
 
Note: Before you start the Add-on Tool for Alarming you need to make sure you already enabled 
the Alarming functionality in the Web Editor and the ‘.csv’ file (Default: ‘SwebText.csv’) generated 
by the Web Editor has the right amount of alarm entries. Please refer to the DDC Suite manual for 
more information. 
 
 

4.11 Firmware downloader 
 

With this new version, it is possible to display the full file name as tooltip when hovering over the 
file selection box. It is also possible to resize the window in order to display the entirely file path. 
The size and the position of the window are saved and restored in the next session. 
 
Warning messages are now displayed when downloading firmware from version 1.10 and 1.14 to 
1.16 in order to prevent user from configuration, data or user program lost.  
 
The downloader is now able to update the firmware of communication modules that are 
accessible over SPI, for example PCD3.F2xx modules or PCD2.F2xx modules. 
 
 

4.12 FBox Builder 
 

4.12.1 Speed improvement 
 
The XML handling for the language database is completely replaced and it loads the same 
database 30 times faster. It loads the existing databases and saves them back in the new format. 
Improved handling for the line breaks and the % character in the texts.  
 

4.12.2 Find and Replace 
 
The handling and behaviour of Find/Replace became compatible with any other PG5 application, 
the dialog remains open and Copy/Paste is working with the standard ‘Ctrl+C’ / ‘Ctrl+V’ key 
combinations.  
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4.12.3 Library version 
 
The FBE compiler automatically generates a symbol in the lib file for the Library version 
 
_LIBVERS_.<LIB_ID> EQU <vers> 
 
This symbol can be used to get the versions of the used libraries and check the version of the 
library from an another library ( in case of dependency ). 
 
$if __LIBVERS__._USED_LIB < _MIN_VERS 
  $Fatal Wrong version: @__LIBVERS__._USED_LIB@. Must be @_MIN_VERS@ or 
higher ! 
$endif 

4.12.4 Batch Build 
 
With the new command line parameters, the FBox Builder can restore the project from the Backup file 
and create the installer in the specified folder: 
 
FBE /restore=<CAB file> /helpfile=<help file folder> /createpack=<saiazip 
with full path to create> /s 
 
/restore: CAB file to restore, it will be restored to the default FBE project path. 
 
/helpfile: Folder for the updated help files, it will copy only the files to the project which are 

used in it. 
 
/createpack:  Installer file to create with full path. 
 
/s:  Silent mode, exit from FBE when finished. 
 
It can also create the package from the existing project: 
 
FBE <full path of the lbl file> /build /createpack=<saiazip with full path 
to create> /s 

4.12.5 Auto Formatting 
 
Syntax highlighting is updated with some missing instructions (for example STL and indexed 
instructions). The auto formatting is disabled for $WRFILE lines. 

4.12.6 Adjust Init and Default values 
 
Init and default values are imported correctly from Fupla exported pages, and their range 
checking is also corrected (error caused by negative values). 

4.12.7 Help and FBox Info 
 
The language dependent Help templates are used to create the help file. When the short FBox 
Info (displayed in Fupla in the Selector window when the FBox is selected) is not specified by the 
FBox developer then the FBox compiler will automatically use the short description from the Help 
Editor. 
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4.13 HMI editor 
 
Fix some smalls anomalies: 

 Compilation with external I/O 
 Remove unused symbols 
 Compilation with resource type constant 
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5 Service Pack 1 for PG5 2.0 (version SP2.0.150) 
 

5.1 General 

5.1.1 Flags range extension with addresses up to 14335 
The flag address range has been extended from 8191 up to 14335. NT devices powered with a 
firmware version 1.14.23 or more recent can support the extended flags range from 0 to 14335. 
 
How can we check if a device supports the new extended flags range? 
Open the Device Configurator, select the “Device, Type” and display the properties. 
If the “Firmware version” option is displayed and the following hardware requirements are 
satisfied, the flags extension can be supported: 
 

o PCD3.M5xxx, M6xxx, M32xx, M33xx with minimum hardware version D 
o PCD3.M30xx, M31xx with minimum hardware version E modif 48 

 
Before using the new flags extension, please, check if the device properties present in the Device 
Configurator is selected with: 
 

 
 

5.1.2 Support for new hardware 
The following devices are now supported: 

o PCD1.M2120 
o PCD3.M5560, 6360 and 6560  

For those specific devices, a new block file download procedure has been implemented. 
 
The new Bluetooth modules PCD2/3.F160 and PCD2.F2/3.F2xx equipped with a F160 are fully 
configurable using the Device Configurator. 

5.1.3 Assembler 
In S-Asm string handling, the ‘STR’ data type and ‘@STR()’ operator have be improved with more 
flexibility. For more information, please have a look in the Instruction List help, available from S-
Edit. 

5.1.4 Project Manager 
The ‘Icon Editor’ for the ‘HMI Editor’ can now be started directly from Saia Project Manager with 
the ‘Icon Editor’ command under the ’Tools’ menu. 
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5.1.5 New FBox libraries 

 Wide Area Automation 

  
This library is useful to create Fupla applications that control PCD-WAC systems. Those FBoxes 
support the most standard functions needed to control Ethernet, PPP and TCP/IP 
communications in a Wide Area Topology. Further operations and more complex applications can 
be made with IL modules. 

  
Following is an overview of the FBoxes present in the library. 
 

Life Check Execute life check of the network connections and target 
system by mean of ping requests. 

PPP Status Read the status of the PPP link. 
PPP Start/Stop Allows you to start and stop the PPP link. 
DynDNS Execute  DynDNS registrations. 
GPRS Status GPRS Status 

 
 
S-bus Energy meter 
 
This library allows data access to the Saia S-Bus energy counter. The following energy meters 
are supported: 

o ALD1 
o ALD3 
o AWD3 
 

In placing one of those FBoxes in a Fupla page, group of symbols with the counting values, reset 
for the partial counter will be automatically created. 
BACnet objects can also be created easy in selecting the corresponding adjust parameter. 
 
 

mk:@MSITStore:C:\Users\ch2capi0\AppData\Local\Temp\SaiaInstaller\WideArea_en.chm::/life_check.htm�
mk:@MSITStore:C:\Users\ch2capi0\AppData\Local\Temp\SaiaInstaller\WideArea_en.chm::/pppstatus.htm�
mk:@MSITStore:C:\Users\ch2capi0\AppData\Local\Temp\SaiaInstaller\WideArea_en.chm::/ppp_startstop.htm�
mk:@MSITStore:C:\Users\ch2capi0\AppData\Local\Temp\SaiaInstaller\WideArea_en.chm::/dyndns.htm�
mk:@MSITStore:C:\Users\ch2capi0\AppData\Local\Temp\SaiaInstaller\WideArea_en.chm::/gprs_status.htm�
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5.1.6 New FBoxes 

Quary IP Name (Communication FBox) 

This FBox resolve alphanumeric DNS name to an IP address. 
 
 
 
 

 
 

 

Fan Max Position (HVC Controllers) 

The FBox outputs the maximum value of the input values.  
It is made to deliver the maximum damper position for the  
Fan Optimizer FBox. 

 
 

Fan Optimizer PI. (HVC Controllers) 

The FBox is a PI controller especially designed to optimize fan  
speed depending on feedback position of dampers. 

 
 
 
 

Easter Days (HVC  Clocks) 

This FBox allows you to detect Christian feast days based  
on Easter. 

 
 
 
 

Clock 4*8 days + offset (HVC  Clocks) 

This FBox has the same functionality as the 'simple 
' Clock 4*8 days but it can also apply an offset to the first  
Switch ON time of each day and it returns a switching On and  
Off times. This can be used, for instance to optimize the Startup  
of heating and air conditioning. 

 
 
 
 

Dead Range with Delay (HVC Filters) 

This FBox limits the frequency of value changes.  
It drastically reduces the traffic load on variation driven  
communication. 

 

mk:@MSITStore:C:\Users\Public\Saia-Burgess\PG5_20\Libs\App\Heavac_fr.chm::/wochenuhr_mit_4_einschaltungen_pro_tag.htm�
mk:@MSITStore:C:\Users\Public\Saia-Burgess\PG5_20\Libs\App\Heavac_fr.chm::/wochenuhr_mit_4_einschaltungen_pro_tag.htm�
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Gradient (HVC General) 

New FBox to compute the gradient (variation per hour,  
minute or second) of an integer value. 

 

 

Read GSM Status (Modem) 

This new FBox can be used to read status of GSM modem. 
 
 
 
 
 
 
 

5.1.7 FBox corrections 
 

Command Filo/Fifo (HVC General) 

The functionality of this existing FBox has been improved 
with the following: 
 
Redundant command for 2 to 8 pumps with automatic priority  
changeover depending on the run hours. The switch-on are  
made on the pump having the less working hours. For a FIFO  
buffer, the switch-off are made on the first pump switched on in 
the buffer. For a FILO buffer, the switch-off are made on the last 
pump switched on in the buffer. 
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5.2 Fupla Editor 

5.2.1 Copy and Paste FBox Name and Adjust parameters 
With the Fupla editor, it is now possible to select one FBox and copy/past the adjust parameters 
using the context menu "Copy Adjust Parameters" and "Paste". The same function can be done 
with the FBox name and reference, in using the context menu “Copy Name”. 
Copy/Paste adjust parameters is available in online mode too. 
 

 

5.2.2 Display format IP for online probes, Edit Data and Watch Window. 
 

 
 
The new “IP” format allows displaying hexadecimal IP addresses to the standard IP address. 
 
Sample: Hexadecimal IP address in a register:  0C0A80120H 

Means:       0C0.A8.01.20H  
Corresponding to the IP address:  192.168.1.32    

 
This format is also available in the ‘Edit Data’ dialog in Fupla and also in the ‘Watch Window’. 
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5.2.3 Can edit time format without the char”:” 
In the FBox Property dialog and in the ‘Adjust Window’, it is no more needed to use the character 
“:” as separator between hours and minutes.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This functionality is also available in the ‘Watch Window’. 
 

5.2.4 Offline adjust parameters 
Offline adjust parameters are now displayed in the online adjust window, if we select the button 
‘Show Source Value’.   
 

5.2.5 D&D Fupla in the Page Navigator 
The Fupla Page Navigator displays the list of Fupla pages according to the blocks. 
It is now possible to change the page order or move a page to another block with the drag and 
drop. 
 

5.2.6 Speed improvements 
Improvements regarding speed have been done for the ‘Go Online/Offline’ operation from a Fupla 
file, for the ‘Go in Run’ operation and for the page navigation. 
Improvement have been done in order to improve the speed in Online communication with Fupla 
and in online mode over phone line (modem). 
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5.3 Symbol Editor 

5.3.1 Improve the symbol definitions for array and reference definitions 
With just one command is now possible to create an array of symbols, referenced to the first array 
element. If the array size is too short for all the symbols range, the symbols definitions outside the 
array are not defined and an error message is displayed in the symbol editor. The symbols 
addresses inside the array are referenced to the first symbol element. So this is very easy to 
change the array base address. 
 
Sample: the command“ABC1..10 r 100[3]” defines the next symbols: 
 

 
 

5.3.2 Edition of symbols without mouse 
In the Symbol Editor, new characters can be inserted into symbol names without using the 
mouse. We can move vertically or horizontally to the next cell and insert characters with the 
command ‘Shift+F2’. 

5.3.3 Change scope 
The symbols editor grid offer a new menu command ‘Change Scope’ for the selected group or 
symbols. 
 

5.3.4 Tool tip 
‘Ctrl+Space’ can be used inside the Symbol Editor 
expression fields to look for expression that start with 
the same characters. 

 

5.3.5 Group comments 
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Group and symbols comments can be defined with a comment line. 
o For a group comment, enter ‘;G ’ and the comments, like : ‘;G My comment for group’ 
o For a group comment as constant, enter ‘GRComment K 1 ; Group comment’ as symbol. 

 

5.3.6 Sort Symbols 
The Symbols Editor offers a new advanced menu “Sort Symbols” for customizing the symbol 
sorting in the grid. The specified order is applied to save the symbols into the file. This default sort 
is again applied if we open the file. It is still possible to sort the list manually by clicking on a 
header or using the symbols drag & drop.  
 
 

5.4 Watch Window 

5.4.1 Symbols with a small and big magnitude on the same trend 
If symbols values present on a trend have a different magnitude, the symbols with a wide 
variation use all the vertical scale and the symbols with a small vertical magnitude use only a 
small fraction of this vertical scale. 
 
There is now two possibilities to improve the visibility of the values: 
 

1. A ‘Trending scale factor’ can be defined in the properties of the symbol. It allows to 
amplifier or reduce the magnitude on the symbol values in the trend. The user must then 
take into account this factor to read the vertical scale in order to get the right value. 

 
2. A second scale (second Y axis) can be add at the right of the trend. Select the symbol in 

the watch window grid to display the properties window and assign the symbol to the left 
or right scale with the properties option “Trending, Axis”.  

 
Note: The trend is always better if the vertical scale is automatically adapted to the symbol 
magnitude. Select the trend properties and set the option “Left/Right Axis, Auto adapt Y Scale” 
with Yes. 
 

5.4.2 Trend with several binary symbols 
If the trend of several symbols has the same magnitude on the vertical scale, it is possible to 
define a offset that will be add to the symbol value. This offset is usually automatically defined for 
binary symbols and can be displayed or modified using the symbol properties “Trending, Offset”. 
 
 
 

5.5 Device Configurator 
 

5.5.1 Configuration of the TCP/IP extension 
The configuration of the TCP/IP extension protocols and some other firmware parameter and the 
download or upload into or from the device are completely integrated into the Device 
Configurator. The use of configuration files downloaded over FTP is no more necessary.  
 
The following functionalities can be now configured: 

 Transfer protocols: FTP, Http direct 
 IP protocols: DHCP, DNS, SNTP, SNMP 
 PPP protocol on every RS-232 communication port 
 Web server parameters 
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5.5.2 Support for new hardware 
The Device Configurator allows the configuration of the following new devices: 

 PCD1.M2120,  
 PCD3.M5560, PCD3.M6360 and PCD3.M6560 
 Bluetooth modules: PCD2/3.F160 and PCD2/3.F2xx equipped with F160 module 
 eDisplay PCD7.3100E 
 

5.5.3 Configuration of the eDisplay 

 
The embedded Display of the PCD2.M5xxxx (eDisplay) must be, from now on, configured with the 
device configurator. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.5.4 Online settings 
The ‘Online Settings’ can be change directly from the Device Configurator in ‘Online’ menu, using 
the ‘Online Settings …’ command. 
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5.6 HMI-Editor  
Two new features are available in the HMI-Editor:   
1) Load global resources without constants. 
2) A.HVC filter for HEAVAC applications 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
5.7 Setup PG5 

5.7.1 Silent installation mode. 
In using the command line parameter ‘/s’, it is possible to run the PG5 installation in silent mode. 
The dialogues for selecting the features, the installation path and the license key are not 
displayed.  
In this mode, the setup applies a default installation: 

 With all the features present in the setup. 
 Apply the default installation path “C:\Program Files\SAIA-Burgess\PG5_20” *. 
 Use the valid license already installed else install a demo key.  

 
*: Drive ‘C’: if your Windows operating system is on that disk. 

 
For user which would like define another installation path, it is possible to complete the command 
with “/v”/qn INSTALLDIR=Your_Installation_Path” 
 
Example: 
"Setup PG5 Suite V2.0.exe"   /r /s /v"/qn INSTALLDIR=D:\SAIA\PG5_20110" 
 

5.7.2 Windows operating system necessary supported with this service pack 
PG5 V 2.0 Service Pack 1 can be installed on Windows 2003, Windows  XP, Vista 32bit, 
Windows 7 32 bit and Windows server 2008. 
 

5.8 Bues 
The PG5 2.0 Service Pack 1 supports all Bues features.  
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5.9 Web-Editor 5.14.30 

5.9.1 Enhancements 

1. Saia Certificate for the IMaster Applet 

 
By popular request we have now an official certificate for our Applet from a certification authority 
 
The disturbing message in the PC browser when calling the PCD web pages is now gone and the 
security warning is presented as follows: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

By 

selecting the check box "Always trust content from this publisher" the warning is not anymore 
displayed when accessing the PCD web page. 

2 Macro "URLJumpOnMouseDown" 

 
Now in the macro dialog the user can select in what frame (_self, _parent, _top, _blank) the URL 
shall be opened  
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3 New PPO-Format "String-i" 
 
In the PPO list a new format "String-i" for PCD texts can be selected. By this PCD texts with 
formatted data ($Rxxxx etc.) can be displayed. 
 
 

1.4 New display formats for Date/Time within Alarming and Trending 
 
Now the Date/Time display format for Alarming and Trending can be selected in the "Project 
Configurations" Settings. 
 
      This is not yet supported by the actual Micro-Browser versions. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The selected display format is saved in the HTML file with the HTML tag "PM_AM"  
(values 0 to 7 correspond to the options shown above).  
 
 
 
 
 
 
 
 
 
 
 
The display format can be changed during runtime using the language csv files. 
For this the parameter "PM_AM" has to be modified manually in each language csv file. 
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5.9.2 Bug fixes and improvements 
 
1 PPO format "string" for Alarm.Name text 
 
When inserting an Alarming Macro the Alarm List name was not anymore declared as String in 
the PPO list.   
 
 
 
 
 
 
 
 
 
 
2 Password Macro "PasswordDialog_UserLevel_5_13_40" 
 
Caused a dialog timeout when selecting a PCD text in the PG5 symbol selector. 
 
 
3 Error when opening a Macro Dialog in Windows Vista und 7 
 
On PCs with limited user rights the macro dialogs could not be opened, because copying "exe" 
files ("Macrodlg.exe") is not allowed with Windows Vista und 7. Now the "exe" file is not anymore 
copied.  
 
 
4 FTP download in Web-Editor 
 
Generates now a correct error message in case of failed transmission.  
 
 
5 Painter objects with empty fonts 
 
If the user has accidentally deleted the font in a Painter, this caused problems with old Web-Editor 
and Micro-Browsers. Now empty fonts will be replaced by Arial by the Web-Editor during project 
save. 
 
 
6 Opening Macro Dialogs with large projects 
 
For projects with a large number of pages (> 50) to open the Macro Dialog with version 5.14.27 
lasted longer proportional to the number of pages. 
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7 "Project Build" warnings 
 
After "Project Build" depending on the use of HTML tags and macros with the new configuration 
dialogs, the following warnings are displayed. Now these warnings can be disabled by pressing 
the "Cancel" button. 
 
Warning not used HTMl tags: 
 
 
 
 
 
 
 
 
 
 
This warning appears when the user in the CSV files manually enters their own HTML tags. This 
is for example the case if you want to use via html tags indexed texts. Refer also to Online Help 
"Working with Error Codes". 
 
Warning new Macros with Configuration Dialogs:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This warning is displayed when a project is edited, which was created with an older version of 
web editor (< 5.14.27) The project contains macros which still has no dialogue, and therefore can 
not be stored in the project directory "PrjMacroLibTempFiles". 
 
Once disabled with the "Cancel" button these warnings are not anymore displayed.  
In the "project Build Advanced" settings the warnings can be activated again. 
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8 Improved work flow when modifying Macros with configuration dialogue 
 
Remember:  
Macros, which have a configuration dialogue should be modified and stored in the library as 
described below. 
 
The work flow was designed more intuitive, unnecessary messages left out and explanatory 
messages added. Thus, possible sources of error can be reduced. 
 
A. Change the Marco’s name using the following menu command: 
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B. Select the Marco and insert into the page. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Then ungroup the Marco, make the changes, and then regroup the Marco. 
 
 C. Store the Marco in the Marco Library under a different name. 
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5.9.3 Documentation and example applications 
 
The online help is available in English and German. The correct language will be selected based 
on the installation of the Editor. New in the Online-Help all error messages and warnings are 
listed and explained. 
 
Together with PG5 Controls suite also the Web-Editor PDF help files are installed in German or 
English.  
 
Further information can be found in the Programming Guideline for the Web-Editor. The 
Programming Guideline describes the uses and functions of the Web-Editors by means of simple 
programming examples. The Guideline and PG5 programming examples are available on 
http://www.sbc-support.ch  
 
 
 
 
 

 
 

http://www.sbc-support.ch/�
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6 Release PG5 V2.0.110 
 

6.1 PG5 2.0 installation and compatibility 
 

6.1.1 Minimum computer requirements 
PG5 2.0 works under Windows XP (SP2) and Vista 32 bits.  
Microsoft .Net 2.0 must be installed on Windows XP (available on the installation disk). 
 
For best performance, we recommend installing PG5 2.0 on a PC with processor Pentium 2 GHz 
or 1.6 GHz Dual Core with a minimum of 1GB RAM. The installation package requires about 100 
MB of free space on your hard disk.  
 

6.1.2 Firmware requirements for full PG5 functionality 
It's important to use the latest PCD firmware versions to get the full functionality of the new PG5. 
The latest firmware can be found on Internet: http://www.sbc-support.ch or on installation DVD: 
‘<DVD drive>:\Firmware Files’.  
 
 

6.1.3 Compatibility with the previous versions 
 
Compatibility with PG5 projects version 1.4 
PG5 V1.4 projects are upward compatible with PG5 V2.0, but not back again. Once a project has 
been opened with the new PG5 V2.0, it is not possible to open it again with the previous versions 
(since files are converted to the new format).  
 
We recommend to use different project directories for each PG5 version so they do not get mixed 
up. Projects made with the PG5 1.4 must be imported or restored in PG5 Ver. 2.0. This makes a 
new copy of the project and converts the files to the new format. The original project stays 
unchanged.  
 
Saia–Burgess has taken all the necessary precautions to guaranty the compatibility between the 
PG5 projects V1.4 and 2.0. But old projects written with PG5 1.3, PG4 or PG3 have not fully 
tested. If some projects must be anyway imported from theses old softwares versions,  we 
suggest try to import. If errors happen during the importation or the build after the importation, this 
is always possible to import the project to the version PG5 1.4 first then to the version 2.0 
 
Compatibility with the user FBoxes written for PG5 1.4 or previous versions 
 
The FBox libraries from old versions have to be update to be used under PG5 V2.0: 

 The file .lin is extended to support all info necessary for the Library Manager: the file 
receive a new extension: .saialin 

 Help files have be converted to the new format .chm because the old format .hlp is no 
more supported with Windows Vista 

 New file name convention to support multi-language files. The files are no more in a 
subdirectory but complete with the language prefixes : *_en.chm, *_de.chm, … 

 

http://www.sbc-support.ch/�
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All the Saia-Burgess Controls libraries installed with the PG5 2.0 are already updated to the new 
version 2.0 and they are compatible with the projects of the previous version. Even the very old 
libraries like Heavac Dialog and Room Controller V10 are also updated to PG5 2.0! 
 
The libraries written by our users with the previous version must be updated to PG5 2.0. This 
update can be supported by the library author or the end user itself. There are several ways to 
perform the update: 
 
The new Library Manager available in the Saia Project Manager (Menu: ProjectsLibrary 
Manager) offers a new button “Library Converter” to import and update user FBox libraries from 
PG5 1.4 to PG5 2.0 (Click the button, define the path to the source library 1.4, define which 
libraries have to be converted and the path for result of the conversion.) 
 
Library converter and limitations: the FBoxes libraries can be protected by different ways: license, 
check of the assembler version, …  The library converter never broke the licenses. A new license 
must be ask to the author  for the version 2.0! 
 
If the user FBox library to update is installed on the computer, the FBox Builder can import and 
update the library into a new project and installation package for PG5 2.0 can be created.  
(Open the FBox Builder, command “Import, Family …”, browse to the FBox family and build the 
installer for PG5 2.0). Note a license is necessary for the FBox Builder. 
 
For the author of the libraries, the FBox Builder projects written under PG5 1.4 are compatible 
with the FBox Builder version 2.0. This new version allows creating libraries installer for PG5 
versions 1.4 and 2.0 from the same library project. (See project properties) 
 
PG5 compatibility restrictions 
 
The following features are no more supported with PG5 2.0: 
- PCD4 and PCD6 devices. 
- S-Net for the I/O PCD1 
- S-Net Configurator for Profibus FMS 
 
If some projects with theses old products must still be maintained, PG5 version 1.4 and 2.0 can 
be installed on the same computer. Please, continue to use the PG5 V 1.4 for theses projects. 
For all other projects, PG5 V 2.0 can be used without restriction. 
 
Compatibility with old Windows operating systems 
PG5 2.0 is not designed to run under the following operating systems: Windows 95, 98, ME and 
NT and 2000. 
 
Software Protection 
PG5 2.0 needs a file USER.KEY version V 2.0, the key file from V 1.4 can’t be used. PG5 2.0 
runs for 90 days without a key file.  
 

6.1.4 Windows Vista 
 
PG5 2.0 is adapted to be compatible with new Windows Vista operating system. 
 
Help format 
Vista does not use help files with the old '.hlp' format, all the help files use the new '.chm' format. 
The help files for the FBoxes libraries developed with FBox Builder are automatically created in 
the new help file format. 
 
New files paths  
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Some PG5 files are not installed in the same places, because the Windows Vista doesn’t allow 
modifying files in the 'Program Files' directory without administrator rights. So these files have 
moved to the location provided by Windows Vista. 
 
The PG5 projects, libraries, templates and S-Net '.dat' files are installed by default in the Public 
Documents directory. That means:  
For Windows Vista:  C:\Users\Public\ Saia-Burgess\PG5_20 
For Windows XP:     C:\Documents and Settings\All Users\ Saia-Burgess\PG5_20 
 
The specific user settings for the different editors and S-Comm driver are no longer saved in the 
Windows registry but in the directory defined specially for this kind of data:  
Windows Vista:  C:\Users\<user name>\AppData\Local\Saia-Burgess\PG5_20 
Window XP:    C:\Documents and Settings\<user name>\Local Settings\Application Data\Saia-
Burgess\PG5_20 
 
The license file (USER.KEY) and the '.5at' files used to register the add-on tools are in the 
following directory: 
Windows Vista:  C:\Users\Public\Saia-Burgess\PG5_20\LocalDir 
Windows XP: C:\Documents and Settings\All Users\ Saia-Burgess\PG5_20\LocalDir 
 
 
It is possible to modify (but not recommended) the project and libraries paths from the Project 
Manager menu Tools -> Options. 
 
 

6.1.5 Installation “PG5 Suite”, “XX7 Suite” and “Stand alone tools” 
 
Main changes 
 
There is only one installation package “PG5 Suite” to install all the PG5 applications and all add-
on tools. We can choose the features to be installed. 
 
A second installation package “XX7 Suite “is available to install all the add-on tools necessary to 
the XX7 users. We can choose the features to be installed. 
 
All our installer has the same installation process and user interface.  
 
Setup PG5 Suite (CD:\PG5 Suite) 
One modular setup to install all the features required for programmers of PCD Classic. This setup 
allows you to choose from following features to be installed:  

 Programming Tool PG5 
 Firmware Downloader 
 Online Tools 
 HMI Editor 
 Web Editor 
 Web Builder 
 Saia.Net Web-connect 
 Can Configurator 
 BACnet Configurator 
 FBox Builder 
 Libraries 

 
Stand Alone setups (CD:\ XX7 Suite) 
One modular setup to install all the features required to XX7 users. 
This setup allows you to choose from following features to be installed: 
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 Device Configurator XX7 
 Firmware Downloader 
 Web Editor 
 Saia.Net Web-connect 
 

Stand Alone setups (CD:\ PG5 Stand Alone) 
This setup allows the separate installation of each component PG5 Suite or XX7 Suite. 
Use it only if required for special requirements.  
We suggest using usually the installers PG5 Suite or XX7 Suite. 
One setup for each of the next features: 

 Online Tools 
 Saia.Net Web-connect 
 Web Editor 
 Can Configurator 
 BACnet Configurator 
 Libraries 
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6.2 Graphical interface 
 

 

6.2.1 Multiple document interface for Fupla and Graftec editor   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fupla and Graftec editors can open several program files inside the same document interface. 
The editor shows one frame or pane for each opened file. The selection of each pane displays the 
corresponding program and symbols editor. The editor menus and toolbar buttons are working on 
the selected file.  
 
 
Advantages: 
We can open several files simultaneously for edition or online checks. 
We can easily copy and paste part of programs to other file. 
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6.2.2 New layout for Saia Project manager 
 

 
 
By default the project manager and the programs editors are displayed on the same view, one to 
quoted of the other. The programmer can maximize the Project Manager or the editor view to use 
all the screen area or restore down to the original layout. The Project Manager and editor are 
displayed on the same view again. 
 
If we want to keep the same layout like the previous version 1.4, go to menu Tools-> Options and 
select Desktop Docking as off. 
 
When desktop docking is enabled, a double click on the title bar will maximize the editor window 
(full screen) and re-dock the editor window when it is restored down. 
 
Advantages: 
The PG5 application looks like a framework. 
It is easy to switch between source files defined in a device. 
Double click on the title bar and editor uses entire screen or back to the desktop docking. 
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6.2.3 Docking functionality for all editors 
 
The docking windows are supported by all editors for more flexibility. The Project Manager and 
Editors Fupla, IL , Graftec supports docking windows.  
 
 

 
 
 
 
 
 

The docking windows position can be set according the user wishes. To change the position of 
docking window, select the docking window from the title bar, then drag & drop to a new 
placement. The new docking window position will be fixed at the destination icon used as target.  
 
 
 
 
 
 
 
 
 
 
 
 
The Auto hide button allows changing the docking window to a pane on the side of the main 
window. If we place the mouse over this pane the docking window is displayed. 
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6.2.4 Standard property grid for all editors 
 
Standard Properties grid is supported by all editors for simpler handling. Device configurator, 
Project Manager and Editors Fupla, IL, Graftec all support standard properties grid. 
 
 

 
 
If we open the Device Configurator, Project Manager or any program editor (Fupla, IL, Graftec), 
the dialog boxes are replaced by a Properties Window. 
 
So, all the graphic interfaces are consistent. The selection of any object, one FBox in the Fupla 
editor or one communication board in the Device Configurator, always displays all the parameters 
corresponding to the selections in properties view. 
 
All the properties views works in the same way, the parameter description is displayed on the left 
side and the selection on the right side. The parameters can be a string or value to edit, multiple 
selection or a toggle.  
 
The selection of any property shows a short description or help at the footer of the view.  
 
To edit a property, we can edit a value with the key board or select a parameter in a list. 
 
Good to know: 
The selection of a property cell with a double click of the mouse works like a toggle. This selects 
the next parameter in the list. (Try on a cell with options Yes/No) 
 
Advantages: 
Standard components for a more simple handling 
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6.2.5 Error list window for all editors 
 

 
 
If an error happen in an Editor Fupla, IL,  Graftec,  Project Manager or in Device Configurator, 
error window shows the list of errors and warnings with a short description  and indication to the 
location of the trouble. If we select one error message, the editor displays the page or property 
grid with the error. The error window can be displayed from View Menu. 
 
 

6.2.6 Tool bars 
 

 
 
 
The Toolbars are scattered in several smaller tool bars which can be displayed or kept hidden 
according to our needs from menu View->Toolbars. We can select a different tool bar layout 
according we are online or off line. 
 
Advantages: 
If we resize the editor frame, the tool bar layout can be adapted. 
So that all buttons can still be reach. 
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6.3 Symbol editor 
 

 
 
The symbol editor has been fully rewritten with C# and .Net, Globals symbols are no more 
managed like the previous version, the program files formats have been improved, the symbols 
process flow have changed and the grid to edit symbols is more flexible. 
 
 

6.3.1 Public symbols 

The “Globals” symbols have been renamed to “Publics”. The functionality and the scope of the 
Publics symbols are the same. Public symbols can be used inside the file where they are defined 
as well as in all program files present in the same Device.  
 
The Local symbols have still the same name and functionality. Local symbols can be used just 
inside the file where they are defined. 
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6.3.2 Program files format 
 
Publics and local symbols definitions are saved with the program file Fupla, IL or Graftec and no 
more in two separate files with an extension sy5.  
 
Each program file present in the device contains Publics symbols definitions. Publics symbols 
definitions are no more defined in a centralized file “Globals.sy5” but scattered between all 
programs files linked to the device. 
 
Previous PG5 versions 
 
Feature: 
 
 
 
With the previous PG5 versions, the symbols and the programs were saved in three different files. 
But just the program files were displayed in the project manager tree. Theses files were: 
 
- Fupla, IL or Graftec program files displayed in the project manager tree. 
- A file with the same name and the extension ‘sy5’ for the local symbols definitions. 
- A file ‘_Globals.sy5’ for the global symbols definition. 
 
PG5 2.0 
 
 
 
 
 
The Program and its symbols definitions are saved in the same file, the Locals and Publics 
symbols are saved with the Fupla, IL or Graftec file.  
 
Old projects imported into PG5 2.0 
 

 
 
 
Even if the program files format has changed with the PG5 2.0, all the users projects written with 
the previous versions are supported. The project importation or restoration updates the project to 
the new file format.  
Anyway be careful, the projects imported to PG5 2.0 can no more be opened with the previous 
versions!   
 
If we import old projects from previous PG5 versions, the importation don’t know how to move the 
symbols from the file ‘_Globals.sy5’ to the programs files. So we keep them in the same file which 
is linked to the program files of the device and the user can move them manually or keep them in 
the sy5 file.  
 
Advantages 
All symbols are part of the program file. 
It is possible to drag and drop or copy and paste program files between the devices or projects 
without to lose symbols definitions.  
High flexibility for Publics symbols definitions.  

Program:            Regulation.fup  
Local symbols:   Regulation.sy5 
Global symbols: _Globals.sy5 

Program + Local symbols + Publics symbols 

‘Fup’ file: Program + Local symbols  
 
‘sy5’ file: Additional file for Publics symbols definitions 
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Public symbols are no more centralized to the Globals.sy5 file. 
 
 

6.3.3 Symbols process flow and build process 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Source file: Symbols    S-Net      IL editor 
     Fupla      HMI        Graftec editor 
 
 
 

 
 
 
 
 
 
Object files and listing 
 
 
 
 
Files generated by the build 
 
 
 
 
 
 
 
Device PCD 

Assembling 

Download 
Programme 

Build or Save file  

Updates the view  

ALL Publics 
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Since public symbols are scattered between all program files Fupla, IL and Graftec linked to the 
device, a program build is necessary to collect all symbols used by the program files into one file 
pcx. This file is then used as data base to create All Publics and filtered symbols views present in 
the symbol editor. 
 
Theses symbols views are updated on each program build and each time we open or save a 
program file. 
 
Advantages 
- Build when opening and saving a file. 
- The symbol list is periodically refreshed. 
- It is not necessary to build before to use cross-reference.  
- It is not necessary to make the build before downloading the program. 
- Saving a file updates the All Public symbols view with the last new symbols definitions. 
 
 

6.3.4 Symbol editor and grid 
 

 
 

 
 



Saia-Burgess Controls AG                                                                  PG5 2.0 What’s New 

20/03/2012/1:30 PM                                                                                                                    Page 78 of 108 

 
If we open a new program file, we see a grid with different panes which displays the global 
symbols (ALL Publics), system symbols and editable symbols corresponding to the open files. 
 
One grid has pane with a name corresponding to active program file. This grid has a white 
background colour and allows editing global and local symbols saved with the active program file. 
Now with PG5 2.0 Local and Global symbols are edited in the same grid! 
 
The symbols are still defined with a name, type, address/value and comment and additionally with 
some new features. Now Global and Local symbols are edited in the same grid and we 
differentiate them with Scope. Scope is selected with a new cell Scope and no more by grouping 
symbols in two different grids. 
 
We have still panes with the symbols views: All Publics, System, and Local to the active file. 
(Pane with the program file name) 
 
Local and Public symbols definitions are now edited in the same pane which has the name of the 
active file. For each symbol definition a new scope entry allows to define if the symbol is public or 
local.  
 
On saving the file, a build is automatically performed; this updates the symbol data base present 
in the hidden ‘pcx’ file, and updates the view All Publics with the new publics symbols defined 
from the pane with the program file name and all other programs files linked in the device. 
 
ALL Publics symbols view is disabled for the edition, to edit theses symbols; we usually select the 
symbol in the All Publics view and select the context menu Go To definition. This command opens 
the file which contains the symbol definition and it shows symbol definition.  Symbol definition can 
be edited from source file where symbol has been defined. 
 
If we drag and drop a public symbols defined in other files from All Publics view to the current 
program file, an external symbol definition is automatically added to the local file symbol view. 
External means that a public symbol is defined in another file and used in the local program file. 
 
Tags are new optional entries for symbols. One or several tags can be associated with a symbol. 
This allows a better filtering of symbols, especially when they cannot be associated in groups. 
The tags have no influence on the program and are only additional information that can be 
associated to a symbol. To edit tags, select the cell and enter one or several tags identification 
strings separated by comma. Also If we select the cell one button is displayed on the right side to 
open a dialog with the list of all available tags, then it is possible to select tags which apply to the 
symbol with true or false selection. 
 
If we save or build the file, the actual value column shows the addresses applied to the dynamic 
symbols or the addresses evaluated by an expression.  
 
If some symbols definitions columns are not used, they can be hide with the toolbar buttons A, C, 
S, T or from the context menu. 
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6.3.5 Filters and views 
 

 
 
The tool bar button Show/Hide Tree Navigator shows a view with some predefined symbols filters 
apply on the symbol data base ‘pcx’. The main predefined filters which are corresponding to the 
symbols grids are already been discussed: active program file, ALL Publics and System symbols. 
 
If we select one of those predefined filter from Tree Navigator with a simple mouse selection, this 
shows the corresponding view on the right side (see picture). 
 
For example, the predefined filter ALL Publics can be expanded and offers an access to new 
predefined filters apply just to the ALL Publics one. 
 
If we select one of theses new sub filters with a simple mouse selection it opens a temporary view 
with the selected filter: Block list, Inputs, Registers etc. If we select a second filter, the view is 
removed and replaced with the new selection. To keep this new view permanently open, select 
the context menu Open as new tab or make a double mouse selection on the filter icon. 
 
For each main filter it is possible to define its own sub filters. Select the icon with the program file, 
ALL Publics or the System and select a button New Filter from context menu.  A dialog is 
displayed in order to define the filter properties: Symbol Name, Group name etc. 
 
The entries are validated with the OK button. If the filter must be modified or deleted select the 
filter in Tree Navigator then press the button properties or Delete Filter from context menu. 
 
Advantages 
Predefined filters already present for current views. 
New filters can be defined.  
Filters definitions are saved in the tree. 
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6.3.6 Find symbols 
 

 
 
 
The new symbol editor offers a better find functionality. For locating any symbol definition, a 
regular string can be specified. The regular string is edited in the tool bar with Meta chars ‘*’. The 
two buttons Find Previous and Find Next allows moving the selection to the next position in the 
symbol grid. The find is always limited to the open view and the last regular strings are always 
memorized in a small buffer. 
 
The advanced options available with the button + of the tool bar allows to select/de-select the 
columns used to find  
 
Advantages 
Smart and easy find function  
 

6.3.7 Symbol edition facilities 
 

The grid to edit symbols definitions is very specific to our application domain. The new grid is fully 
house made and supports powerful new functionalities. 
 
This new grid is a combination of the flexibility of an Excel grid and the service of a specific 
symbol editor. 
 
If we open a new file and edit a new symbol or create a new group, an empty line is always 
available in the grid to enter the next symbol. 
 
A new symbol can be edited from Symbol Name cell: MySymbol F 10; My comment 
Several symbols can be edited with one entry: MySymbol1..10 F 10; My Comment 
 
New group can also be created without using the context menu New group (CTRL+G), you can 
just write GroupName followed with a “.” or GroupName.SymbolName in the Symbol Name cell. 
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To drag and drop symbols into program or to select the entire symbol definition line for 
copy/paste, select the button on the left side of symbol name and not the icon visible just near to 
symbol name. 
 
The content of a cell or all the symbol definition can be duplicated or modified by stretching the 
cell (like in Excel).  
 
It is possible to copy and paste symbols or cells inside the same grid 
 
Symbols can be sorted according the Symbol name, Type, Address/Value, Actual Value, 
Comment, Scope, Tags and source. Just click on the column header bar! 
 
One or several symbols can be selected and then use the new context menu  Add To Watch 
Window or the context menu Advanced, Export. Just the selection is exported! 
 
Drag&Drop a symbol from ALL Publics to the program adds its name with an external scope in 
the local file. Scope external means the symbol is used in the local file but defined in another file. 
The cross reference and the context menu Go to Definition opens file with the global definition. 
 
Saving the program file refreshes the ALL Publics symbols view with the new definitions. 
 
Renaming a public symbol definition updates symbol names where ever the symbol is used in the 
source files of the device. 
 
Renaming an external symbol definition updates the symbols present in the local file only. It 
Changes the reference. 
 
To move the Global symbol definition to other file, just change the scope external to Global or 
Global to external. 
 
To move a symbol to the file _Global.Sy5 linked to the device, select the symbols and use the 
context menu: Advanced, Add Public symbols to _Global.sy5 
 
Saving the program file allows using Cross reference with the last program changes, new 
symbols definitions. 
Symbols defined by S-Net configurator and the Device Configurator for the media mapping are 
present in the ALL Publics symbols list. So they can be used by the add-on tools like the HMI 
editor, Web editor. 
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6.3.8 Symbol import and export 
 
 
 
 
 
 
 
The global symbol files with a format ‘sy5’, ‘xls’, ‘rxp’ can be linked to the project with the menu 
File->New or Device->Add Files. Menu File->New creates a new symbol file and Device->Add 
Files allows adding a symbol file from another party like an add-on tool. 
 
So, it is no more necessary to import and merge external symbol files with the program symbols. 
This works in a better and easier way, without making symbols merge! 
Don’t forget to check the file properties with the option Symbol file. 
 
Public symbols files with ‘sy5’,  ‘xls’ and ‘rxp’ extension are edited with  the program 
corresponding to their extension or the symbol editor and saved in the original file format: ‘sy5’, 
’rxp’, ‘xls’ etc. 
 
By default we open the file with the symbol editor but the context menu ‘Open with’ opens the file 
with another editor. Take care if you rename the symbol name, only symbol editor is able to 
propagate the change to other program files where ever this symbol is used! 
 
The old way to import and export symbols is anyway still supported with the symbol editor context 
menu Advanced, Import or Export 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The public symbol files placed in the project Common Files folder can be shared with several 
devices. 
 
Advantages 
Public symbols can be saved into several files with a format ‘sy5’, ‘xls’, ‘rxp’ etc.  
The project manager common files folder supports global symbols. (Good to write libraries)  
No more necessary to import and merge symbols from external files, just link the file to the 
device. 

Global symbols can be 
defined into any file ‘sy5’, 
‘rxp’, ‘xls’, ‘fup’, ‘src’,… 
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6.3.9 Sample to define Global symbols with the program file 
 
Public symbols definitions are scattered between the programs files present in the same device. 
Each file linked to the device can contain some public symbol definitions. 
 

 
 
File Analog measure.fup 
This small Fupla file contains a program to read one analogue value shared with the other files 
present in the device. The symbols shared with the other files are defined with public scope. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The ALL Publics view collects all the public symbols defined by the files linked to the device. 
On saving files, the newly added public definitions are displayed in the ALL Publics view. 
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File Process.fup 
The other files present in the device can then use the symbols from the ALL Publics view. 
If we drag and drop a public symbols to the fupla page, the symbol is added to the symbol editor 
with an external scope. This means this is a public symbol defined outside of the local file. 
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Also from this file it is allowed to add new public definition shared with all other files linked to the 
device. 
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File AnalogOutput.fup 
 
If we save the file Process.fup,  the new public symbol definition is available in the ALL Publics 
view and can be used in a third file present in the same device. 
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6.4 Device Configurator  

 

6.4.1 General 
 
  
The Device Configurator enables the configuration of the PCD devices.  This tool replaces the 
Hardware settings dialog box displayed in older PG5 versions. The same functionalities are 
available, like the definition of the device type, the memory, the password, the communications 
and gateways settings. They are just displayed within a new layout. 
 
 

 
 
The Device Configurator main frame contains the following components: 
 
Main view: the main window represents the different communication, memory and IO interfaces 
available on the current defined device. The view is organized in slots:  

 Device slot containing the base device settings like memory, S-Bus station, password… A 
double-click on this slot or the Change Device Type command on the File menu allow 
changing the device type. 

 Memory slots available for definition of flash memory modules. 
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 Communication slots where the available communication interfaces are listed or can be 
defined, by adding a communication module for example on socket A or B of the PCD2 
devices. 

 Onboard slots that shows the available slots where IO modules can be inserted. 
 

Some slots are predefined, other are freely configurable and accept modules listed in the selector 
window. 
 
Property window: the property window displays the parameters of the selected slot in the main 
view. Some parameters are disabled and are only displayed as information, some others are 
enabled only when a main parameter is active, and other are always free configurable. The 
property window contains an information box where a help text relative to the selected property is 
displayed. A pop-up menu is available on each property cell in order to set the default value of the 
property. When a property is different from the default value, the property value is displayed in 
bold. 
 
Selector window: the selector window displays all modules that are available for the device 
defined in the main view. The modules are organized in categories, like analogue IO modules, 
digital IO modules, special function modules, communication modules, memory modules and 
expansion modules. When a module is selected in the tree view, a complete description of the 
module is displayed in the information box at the bottom of the selector window. The available 
modules can be imported in the device view, in a free slot, using copy/paste, drag and drop or 
double click. 
 
Message window: The message window displays the configuration errors and warning. A double 
click on the message window automatically selects the slot where the error comes from. 
 
The device configuration can be uploaded from a connected device by using the Upload 
Configuration command from the online menu. 
 
The Download Configuration command from the online menu can be used for downloading the 
configuration into the connected device. 
 
 

6.4.2 Configuration of communication settings 
 
For the configuration of a communication interface using S-Bus, the following steps have to be 
done: 
 Enable S-Bus and set the S-Bus station:  

o Select the device slot in the main window (first element of the first grid) with a mouse 
click or with the up/down arrow key. 

 

 
 

o On the property window, select Yes on the S-Bus Support property in the S-Bus 
category. For selecting the value in the grid, you can open the list view by clicking on 
the cell and click again on the arrow in the right or by double-click on the cell to select 
Yes. Then specify the Station Number. 
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 Enable and configure the communication parameter on the selected communication interface:  

o Select the desired Onboard Communications slot in the main window with a mouse 
click or with the up/down arrow key. 

 

 
 

o On the property view, enable the Serial S-Bus in selecting Yes on the Enabled Serial 
S-Bus in the Serial S-Bus category.  

o Check and adapt the communication parameter defined in the Serial S-Bus Mode and 
Timing property category. 

 

 
 
Modem, Profi-S-Bus, Ethernet and all gateway type can be configured in the same way. 
 
You will find more information regarding configuration of communication parameters in Device 
Configurator help or in the PG5 User Guide. 
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6.4.3 Configuration of IO handling 
 
 
The IO handling is a firmware functionality that allows the digital and analogue input or output 
values to be directly accessed from media (register or flag). It means that for an input module, the 
value will be automatically copied to a register or a flag. For an output module, the value specified 
to a flag or a register will be automatically transmitted to the corresponding physical output. The 
Fupla or IL program no longer directly accesses the inputs/outputs for the read/write operations 
but works with the media mapping. This functionality is especially interesting for analogue 
modules. 
 
The media mapping function is available on PCD3 and PCD2.M5xx0 devices. However, it is still 
possible to access the inputs/outputs directly without configuring the media mapping. This makes 
it possible to guarantee compatibility with former projects by previous versions of PG5 and 
devices which do not support it: PCD1, PCD2.Mxx0, PCD2.M480 and PCS1. 
 
For the configuration of the IO handling functionality, the following steps have to be done: 
 Enable the Input/Output handling:  

o Select the device slot in the main window (first element of the first grid) with a mouse 
click or with the up/down arrow key. 

 

 
 

o On the property window, set the Input/Output Handling Enabled property in 
Input/Output Handling category to Yes. You can open the list view in clicking on the 
cell and click again on the arrow in the right or you can also double-click on the cell. If 
you select No all the module defined in the IO slots have no influence to the user 
program and will be only defined as documentation. 

 

 
 
 

 Define the IO module in IO slot: 
o From the Selector window, drag and drop or copy and paste the desired IO module 

into a free slot in the Onboard Slots list view of the device in the Main view. 
 
 Enabled the media mapping for the IO module: 

o Select the slot where the IO module is define in the main view by clicking on the grid 
or use the up or down arrow keys. 
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o On the property window, under the Media Mapping category, set the value of the 
Media Mapping Enabled property to Yes.  

 
o Then specify the Media Address from which all the IO value will be defined. The 

Media Type indicates the type of media where the value will be stored – flag or 
register. The Number of Media property indicates the number of media used for 
storing the input or output values. The Symbol Definitions allows specifying the 
symbol names and comments for the specified media. 

 

 
 
On analogue modules, you will find some more properties in order to configure each channel, like 
the range, the minimum and maximum value and other module specific properties. 
 

 
 
The IO handling configuration is stored in a DBX and is part of the user program. The IO handling 
configuration is not downloaded into the device when downloading the hardware settings. But the 
IO handling configuration is uploaded when uploading the hardware settings. 
 
You will find more information regarding IO handling in Device Configurator help or in PG5 User 
Guide. 
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6.4.4 Printing labels for PCD3 IO modules and PCD2.M5xx0 
 
 
Under the Tools menu, the Label Editor command allows starting. This tool enables the 
configuration and printing of PCD3 IO modules labels and labels for PCD2.M5xx0. 
 

  
The Main view contains the labels of the defined IO modules. After selecting a label by clicking on 
it, you will be able to specify the texts and common parameters like font, colour and lines visibility. 
 
Use the Print… command under the File menu to print the labels.  
 
The labels definition is stored together with the device settings. 
 
You will find more information regarding Label Editor in Device Configurator help or PG5 User 
Guide. 
 

6.4.5 Additional functions 
 
As additional functions, the Device Configurator makes check for power consumption of the 
input/output modules and issues warning if it exceeds available power supply from Device or 
expansion modules.  
 
The device configuration takes care about the expansion module combination, especially for the 
PCD3.Cxxx. 
 
A warning or an error is also displayed when a module may have some conflict with the 
watchdog. 
 
You will find more information in Device Configurator help or in the PG5 User Guide. 
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6.4.6 Advantages 
 
Device configurator is designed to configure your overall system. Hardware settings and system 
components like communication modules and IO modules are configured in device configurator. 
When device configurator is used for configuring IO modules, it gives the overall picture of your 
complete system and its components. This is not possible when we use FBox library to access IO 
modules. 

FBoxes for accessing IO modules are part of user program and they use PCD resources. When 
IO modules are configured using Device Configurator, processing of IO signals is handled by 
firmware and IO values are directly available in PCD media. It saves the user program memory 
and resources. 

With the Device Configurator use the media mapping, Saia PCD works with process image. 
Inputs are read at the start of program scan cycle and outputs are written at the end of program 
scan cycle. It is advantageous to have constant input process image throughout the one program 
cycle and updating outputs only once with final state after executing entire user program. (Please 
note that it is always possible to read/write IO signals many times in same program cycle using 
direct access instructions.) 

Symbol definitions for Input/Output channels are edited from the symbol editor dialog opened 
within Device Configurator from IO module properties window. In this way all input and output 
symbols are defined at one place in Device Configurator near to respective IO modules. This is 
convenient to locate and manage all process inputs and outputs symbols. 

Apart from this Device Configurator offers the easy configuration for using special functions like 
counters/encoders. For example counter/encoder functions can be easily configured and used in 
case of PCD3 Compact or with special PCD3.H1xx modules. 
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6.5 Fupla editor 

 
 

6.5.1 Fupla properties window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
While editing a Fupla file, a double click mouse selection on any FBox with a black corner at left 
bottom, opens the properties window. 
 
This window shows all FBox parameters with several sections: the FBox Properties, Adjust 
Parameters, Static symbols and Advanced Info.  
 
The static symbols can be edited by selecting the button on the right side of the line parameters: 
- Rs (define)  
- Fs (define) 
 
The same window displays properties of FBoxes, Blocks or pages according to selections in 
Fupla file. It displays FBox parameters when FBox is selected; it displays Blocks parameters 
when block is selected where as it displays page properties when page is selected.  
 
Advantages: 
One unique view for FBox settings. It is not required to open and close a dialog window. 
Structure similar to Device Configurator 
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6.5.2 Fupla online adjust window 
 
Modifying Adjust Parameters when online 

 

 

 

 

 

 

 

 
If we are checking programs online, a double click mouse on any FBox with a black corner at left 
bottom, opens the Adjust window instead of the properties window. 
 
This view is designed for adjust parameters online maintenances. 
 
The description and source value columns shows the adjust parameters and their values entered 
in the source file properties window. 
 
The Online value column displays the adjust parameter’s current values from the process. After a 
program download the source and online values are the same. 
 
If we select the line of one adjust parameter, the edit Data field present in the tool bar allows to 
modify the online value one by one.  
 
If necessary, we can edit adjust parameters new values from Modify Value column and load them 
on the device one by one with the red arrow button present in the grid or all together with the red 
arrow button in the tool bar.  
 
The button in the tool bar loads all the modified values at the same time. The changes are 
synchronized. 
 
  Writes a single parameter to the process 
 
  Writes all changed parameters simultaneously. 
 
Restoring the original parameters from the Fupla file 
 
After online changes to the adjust parameters, it's possible to restore the original values from the 
Fupla file. 
 
The Show Source Value button fills the Source Value column with the original values from the 
Fupla file. The user restores the Sources Values one by one from the Fupla file to the PCD with 
the buttons ’>’ present in the grid. The tool bar buttons ‘>>’ restores all the modified values at the 
same time. 
 
You can also use the menu command Online, Write FBox Adjust Parameters download Adjust 
Parameters from the Fupla file. 
 

Restores a single parameter from the Fupla file 
Restores all the parameters for the current FBox from the Fupla file 
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Saving the online parameters into the Fupla file 
 
If the parameters which have been changed online are suitable, they can also be saved into the 
Fupla file. 
 

Save a single parameter from the process to the fupla file 
Save all parameters for the current FBox from the process to the fupla file 

 
You can also use the menu command Online, Read FBox Adjust Parameters to upload Adjust 
Parameters from the PCD and save them in the Fupla file. 
 
 
Advantages: 
Source values are now displayed. 
If static symbols addresses defined, their addresses are displayed 
Looks similar to watch window 
 
 

6.5.3 Fupla multiple line comment 
 

 
 
If we are editing a text with multiple lines CTRL+ Enter allow to edit the next line of the comment 
and Enter key ends the edition. The button near multiple line comment allows displaying all the 
text or just the first line.
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6.5.4 Fupla FBox Selector 

 
 
The new FBox Selector still displays FBoxes, Favorites and Templates view. But the Standard 
Application and User FBoxes views are no more present.  
 
All FBoxes families are now displayed in the same view and some powerful features help us to 
search the right FBox or family. 
  
If an FBox family is selected, pressing letter key scrolls to the next family name which begins with 
that letter. If a family branch is open, pressing a letter key scrolls to the next FBox name in that 
family which begins with that letter. 
 
The Selector window's toolbar has a Filter field where a filter string can be entered. For example, 
type ADD and press the Enter key, the Selector window will now show only the FBoxes which 
contain the ADD keyword, which is Floating Point and Integer. To see all the FBoxes again, press 
the Clear Filter button.  

 

Project Manager's Libraries branch shows all the PG5's installed libraries, and libraries local to 
the current Project. Libraries which you don't want to use can be un-checked, which reduces the 
number of libraries shown in the Selector window.  
 
Advantage: 
Powerful features to search the right FBox or family 
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6.5.5 Fupla editor can display FBox which should be update. 
 

 
 
The new FBoxes libraries versions continue to support the previous FBoxes already inserted in 
the Fupla files. Even if the new FBox interface have be modified: new connections input, outputs 
or the adjust parameters… 
 
So the new FBoxes functionalities cannot be supported by the previous FBoxes version already 
insert in the Fupla file without to delete and replace the existing FBox with a new one. 
 
It can happen the user want know which of the FBoxes present in the Fupla file must be replaced 
to support new features.  
 
Fupla editor have now an option in the custom color set, to display theses FBoxes with another 
color. 
 
Menu:   View, Options… 
Parameter:  Workspave, FBox, Color Scheme, Custom Colors 1 or 2 
Color selection:  Update needed and update needed selected 
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6.6 Library management 

 
Because the libraries creation is the best way to increase the efficiency and to reduce the 
necessary time to automate a process, we have introduced several facilities in order to create and 
use libraries.  
 

6.6.1 Library Manager 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We open the library manager dialog from the Project Manager tree with the folder name 
“Libraries”. 
 
This tool shows all the FBoxes, Functions Blocks and System Functions libraries installed with the 
PG5  and backup with the project. For each library, the version author and install path are 
displayed. Some buttons allows to displays the help, install or uninstall the selected library. 
 
The Installed Libraries list shows all the libraries found in the PG5 library files directory, they can 
be used by all the projects. 
 
The Libraries Copied to Project list shows the libraries which have been backup to the open 
project. Only the open project can use these libraries. The installed libraries can be copied into 
the project using drag-and-drop or by selecting the library and pressing the Copy to Project 
button. 
 
User's libraries or versions which are not distributed as standard with the PG5 should always 
saved with the project, to guarantee that the project is complete and the build is successful.  
Note, all the libraries installed by default with your PG5 2.0 should not be backup with the project. 
We insure you to maintain and distribute a compatible version with the next futures PG5 versions. 
 
If the libraries copied to the project needs a license, the project restoration on another computer 
or software PG5 version more recent (2.x) needs to install the necessary licenses. 
If we copy libraries in the project, we don’t copy licenses with the project, we don’t broke the 
software protection! 
 
If different versions of the same library are present, the library to be used for the build can be 
selected with the checkboxes in the Used column. This is available too for the libraries which 
must not be displayed in the Fupla FBoxes Selector. 
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The user libraries written for PG5 1.4 or older must be updated to the new format PG5 2.0. This 
can be supported with the button “Library Converter”.  
 
Note: the library converter has some limitations: the FBoxes libraries can be protected by 
different ways: license, check of the assembler version…  The library converter never broke the 
licenses. A new license must be ask to the author for the version 2.0! 
 
 
Advantages: 
Gives an overview of all available libraries: FBox, FB, SF 
Display the library version, type, distributor information and the help. 
Possibility to attach a copy of the user libraries to the project 
Possibility to disable libraries => only selected libraries can be used in the project 
The project can be build with library delivered by the PG5 or the project. 
Allows installing or uninstalling the libraries 
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6.6.2 Graftec templates 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Graftec sequences very currently used can be saved in a template. Templates works like a 
powerful Copy & Paste function. We mark any Graftec sequence and select the menu Edit, Add to 
templates. A dialog allows defining a group, a sequence name and a free comment attached to 
the template. If many templates have to be collected, theses descriptions help us to navigate in 
the templates similar to Fupla FBoxes libraries.  
 
 
 
 
 
 
 
 
 
 
 
 
All the template collections created by the users are then accessible from any Graftec project with 
the menu View, Templates.  
 
This window shows the template groups with their template names, comments. An icon shows 
how the templates sequences begin and end.  So we can have an idea if the template must be 
added after a step or transition. 
 
The template sequence is added by drag and drop to a step or transition present in the opened 
Graftec file. A dialog displays all the symbols which make part of the program sequence and 
allows modifying their symbol names, address, comments. The template importation is confirmed 
with the button OK.  
 
The template sequence is added in the Graftec file with the comments, Fupla or IL programs and 
symbols definitions. 
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Advantages 
Piece of code can be used like a library or macro. 
Saves time for the edition.  
Consistent with Fupla templates 
 

 

6.6.3 Passing  FB parameters to other  FBs until 7 level 
 

Feature: 
If we create a FB library, it is now possible to pass one parameter of the current FB to call other 
one, so the parameter passed to the FB of the first level can be used to call other FB and so on 
until 7 levels deep. 
 

 
Note: Take care this feature is only supported with newer firmware! 
 
Advantages 
More flexibility for FB libraries 
FB calls are consistent with the macro. 
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6.6.4 Internal symbols for FB 
 

If we create some nice libraries, the parameters interface should allow defining only useful values 
to use the function. The internal symbols are defined inside the block with some new appropriate 
scopes limited to the block instead of limited to the file. So we reduce the risk of data collision with 
a symbol of the same name in another block. 
 
Symbol definition local to the block FB or macro: 
LEQU is now supported with FB and defines a symbol with a scope limited to the Blocks FB, PB 
etc.  If we use this symbol outside of the block where it is defined, this makes a build error. It 
means different blocks can use the same symbol names for different datas. 
 
Temporary symbol definition local to the block FB or macro: 
TEQU defines a symbol with a scope limited to the FB or macro. The value of this symbol is lost 
at the end of the block because the memory address is then affected for a new temporary symbol 
used by another block. Temporary symbols use no register or flags but memory in the device. 
Take care, that feature is only supported with newer firmware! 

 
Sample: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The symbols AAA and BBB looks to be defined two times, but they are different. 
The symbols scopes are limited to block where they are defined: MyFunction1 and MyFunction2. 
The addresses are different. 

 
Advantages 
Associated to a dynamic address, the symbols local and temporary allows to eliminate the 
symbols collisions between the blocks that constitute a program /library 
Local and Temporary equate symbols allows to reduce and simplify the FB library parameters 
interfaces 
The Temporary symbols shares a common memory and memorize the intermediate results, it 
permits to make an economy of Flags, Registers…  
The Temporary symbols values are lost at the end of the block. 
The Local symbols keep the memorized values for the next block call. 
FB symbol definitions are consistent with the macro. Offer the same functionalities 
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6.6.5 IL editor function selector 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The menu View, Function Selector opens a window which shows the Function Block and System 
Function libraries. Each library can be expanded and show the functions it contains. 
 
When a function is dragged-and-dropped into the program, it inserts the code to call the function, 
with the comments for each parameter. Then we have to just complete the parameters with the 
corresponding symbols. The library's include files are automatically added to the project. 
 
The library help file can be displayed by selecting the function in the Function Selector window 
and pressing the F1 key. 
 
The libraries which you will see are selected using the Library Manager. The default is all installed 
libraries. 
 
Note: The new System Function libraries offer powerful new features which are implemented in 
the PCD firmware. They used like FBs except the CFB instruction replaced with CSF. For more 
information, please refer to the library help files. 
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6.7 Graftec 

 
 
 

6.7.1 Option smart cursor  
 

 

 
The new option smart cursor change the way to edit the Graftec structures, we no more need to 
select the mode button before an action. The mode is automatically set according the context. By 
default the option View, Options, Enable smart cursor is enabled after the software installation. 
 
 
 
 
 
 
 
If the mouse is moved on the middle of the step or transition, the Select mode is applied. The 
cursor shows a hand. The double mouse selection opens the element and shows the program. 
 
If we move the mouse down, the cursor icon shows a transition or step according the element 
which will be added just under by a mouse selection. This is the mode insert and inserts a 
transition or a step whichever is applied. 
 
If we move the mouse on the right side of the step or transition the mouse icon shows the element 
which will be inserted on this side by a mouse selection. 
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6.8 Watch Window  

 

6.8.1 Trend Function 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Watch window can now trace a chart with maximum 8 values: registers, flags etc… 
If more data needs to be traced, it is possible to open a new watch window file. 
 
Select the button Show/Hide Trend to display the watch window chart, then set some symbols 
present in the grid with a Trend colour and start the trend with the corresponding button in the tool 
bar. 
 
If we select the view with the symbols or the trend, the properties windows shows some 
adjustable parameters like the trend sample time and scales units. 

Show/Hide 
Trend 

Start/Pause 
Trend Update 
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6.8.2 Log Function 
 
Open Watch Window and open its Properties Window from menu: “View->Properties Window”. 
Select one or several Symbols in the Watch Window grid and set the option “Logging Enable” to 
yes then set to no if the measurement is finished. 
 

 
 
The menu “Online -> Export Data” allows selecting the data to be logged and the time period with 
date and time. 
 

 
 
The button Preview displays the measurements 

 

  
 
The button Export on Export Data dialog saves the trend data in to a file. User provides the name 
and location to save the file. 
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6.9 FBox Builder 
The PG5 2.0 FBoxes libraries uses a new file format: 
 

 The file .lin is extended to support all info necessary for the Library Manager: the file 
receive a new extension: .saialin 

 
 Help files have be converted to the new format .chm because the old format .hlp is no 

more supported with Windows Vista 
 
 New file name convention to support multi-language files. The files are no more in a 

subdirectory but complete with the language prefixes : *_en.chm, *_de.chm, … 
 
 To satisfy Windows Vista requirements: the PG5 projects, libraries, templates are by 

default installed in the Public Documents directory. That means:    
 For Windows Vista: C:\Users\Public\ Saia-Burgess\PG5_20   
 For Windows XP:    C:\Documents and Settings\All Users\ Saia-Burgess\PG5_20 

 
All theses modifications are automatically supported by the FBox Builder if we import libraries 
projects from the previous version:  
 
The projects FBox Builder V1.4 are still compatible with the  FBox Builder V 2.0, the libraries 
files are automatically update to the new library  file format, the library author have just to create a 
new installer. Helps written with the FBox Builder are update to the new format too. 
 
 
The FBox Builder projects V2.0 can prepare FBoxes installer 1.4 and 2.0. 
Since the library installer is not the same for the PG5 1.4 and 2.0, an option is present in the 
library properties to support the creation of installer PG5 1.4 and 2.0 from the same library project.  
 
 
 
 
 
 
 
The FBox Builder V 2.0 can import and update the FBoxes libraries installed with PG5 V 1.4 
If we don’t have the library project 1.4 to disposition, it is always possible to import installed 
FBoxes libraries 1.4 to a project FBox Builder V2.0. Create a new project and add an empty 
family. Then use the context menu “Import”, “Family” and browse to the def file. 
 
 

 
 


	1 Foreword
	1.1 Standard Disclaimer
	1.2 Manuals available with the distribution DVD

	2 PG5 V2.0.220
	2.1 PG5 
	2.2 Web Editor 
	2.3 More information

	3 PG5 V2.0.210
	4 Service Pack 2 for PG5 2.0 (version SP.2.0.200)
	4.1 Installation
	4.1.1 Supported operating systems
	4.1.2 Setup 32 and 64 bits
	4.1.3 New Saia USB driver
	4.1.4 Setup programs and upgrades

	4.2 Ethernet RIO
	4.2.1 Product description
	4.2.2 Configuration with the new RIO Configurator
	4.2.3 More information: quick start document, sample projects and help

	4.3 Device Configurator
	4.3.1 New I/O media mapping window
	4.3.2 What is IO Handling and Media Mapping?
	4.3.3 Media mapping and Firmware version
	4.3.4 Ethernet communication / protocols
	4.3.5 Support for new devices / modules
	4.3.6 Label Editor for PCD1

	4.4 Saia Project Manager
	4.4.1 Program version
	4.4.2 Program information
	4.4.3 New download program dialog
	4.4.4 New flash backup / restore functionality
	4.4.5 Pre and post build scripts
	4.4.6 Windows 7 Jump List
	4.4.7 New build option for PCD1.M2xx0 and PCD3.Mxx60

	4.5 Fupla Editor
	4.5.1 Fupla Unicode
	4.5.2 Logging of FBox adjust parameters
	4.5.3 FBox classification view
	4.5.4 Improved cross-reference handling: search, print
	4.5.5 Import pages
	4.5.6 Others

	4.6 Symbol Editor
	4.6.1 Editing in filtered views
	4.6.3 Speed improvements

	4.7 Instruction List Editor (S-Edit)
	4.7.1 Add Externals to Symbol Editor command

	4.8 Web-Editor Release 5.15.02
	4.8.1 Enhancements
	4.8.2 Alarming 2 functions
	Alarming 2 FBoxes
	PCD firmware versions
	Micro-Browser versions:

	4.8.3 New S-Web templates and Icon Gallery
	4.8.4 User entries in the HTML file
	4.8.5 STEP7 Symbol import
	4.8.6 HDLog to file for xx7
	4.8.7 Other new features
	4.8.8 Documentation and sample applications

	4.9 FBoxes
	4.9.1 FBox classification
	4.9.2 Quick help
	4.9.3 New FBoxes 

	4.10 DDC Add-on tool
	4.10.1 BACnet
	4.10.2 HTM Doc
	4.10.3 Alarming

	4.11 Firmware downloader
	4.12 FBox Builder
	4.12.1 Speed improvement
	4.12.2 Find and Replace
	4.12.3 Library version
	4.12.4 Batch Build
	4.12.5 Auto Formatting
	4.12.6 Adjust Init and Default values
	4.12.7 Help and FBox Info

	4.13 HMI editor

	5 Service Pack 1 for PG5 2.0 (version SP2.0.150)
	5.1 General
	5.1.1 Flags range extension with addresses up to 14335
	5.1.2 Support for new hardware
	5.1.3 Assembler
	5.1.4 Project Manager
	5.1.5 New FBox libraries
	 Wide Area Automation
	Quary IP Name (Communication FBox)
	Fan Max Position (HVC Controllers)
	Fan Optimizer PI. (HVC Controllers)


	5.2 Fupla Editor
	5.2.1 Copy and Paste FBox Name and Adjust parameters
	5.2.2 Display format IP for online probes, Edit Data and Watch Window.
	5.2.3 Can edit time format without the char”:”
	5.2.4 Offline adjust parameters
	5.2.5 D&D Fupla in the Page Navigator
	5.2.6 Speed improvements

	5.3 Symbol Editor
	5.3.1 Improve the symbol definitions for array and reference definitions
	5.3.2 Edition of symbols without mouse
	5.3.3 Change scope
	Tool tip
	5.3.5 Group comments
	5.3.6 Sort Symbols

	5.4 Watch Window
	5.4.1 Symbols with a small and big magnitude on the same trend
	5.4.2 Trend with several binary symbols

	5.5 Device Configurator
	5.5.1 Configuration of the TCP/IP extension
	5.5.2 Support for new hardware
	5.5.3 Configuration of the eDisplay
	5.5.4 Online settings

	5.6 HMI-Editor 
	5.7 Setup PG5
	5.7.1 Silent installation mode.
	5.7.2 Windows operating system necessary supported with this service pack

	5.8 Bues
	5.9 Web-Editor 5.14.30
	5.9.1 Enhancements
	1. Saia Certificate for the IMaster Applet
	2 Macro "URLJumpOnMouseDown"

	5.9.2 Bug fixes and improvements
	5.9.3 Documentation and example applications


	6 Release PG5 V2.0.110
	6.1 PG5 2.0 installation and compatibility
	6.1.1 Minimum computer requirements
	6.1.2 Firmware requirements for full PG5 functionality
	6.1.3 Compatibility with the previous versions
	6.1.4 Windows Vista
	6.1.5 Installation “PG5 Suite”, “XX7 Suite” and “Stand alone tools”
	6.2.1 Multiple document interface for Fupla and Graftec editor  
	6.2.2 New layout for Saia Project manager
	6.2.4 Standard property grid for all editors
	6.2.5 Error list window for all editors
	6.2.6 Tool bars

	6.3 Symbol editor
	6.3.3 Symbols process flow and build process
	6.3.6 Find symbols
	6.3.7 Symbol edition facilities
	6.3.8 Symbol import and export
	6.4.1 General
	6.4.2 Configuration of communication settings
	6.4.3 Configuration of IO handling
	6.4.4 Printing labels for PCD3 IO modules and PCD2.M5xx0
	6.4.5 Additional functions
	6.4.6 Advantages

	6.5 Fupla editor
	6.5.1 Fupla properties window
	6.5.2 Fupla online adjust window
	6.5.3 Fupla multiple line comment
	6.5.4 Fupla FBox Selector
	Library Manager
	6.6.2 Graftec templates
	6.6.3 Passing  FB parameters to other  FBs until 7 level
	6.6.4 Internal symbols for FB
	6.6.5 IL editor function selector

	6.7 Graftec
	6.7.1 Option smart cursor 

	6.8 Watch Window 
	6.8.1 Trend Function
	6.8.2 Log Function



